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MV-8 Series Multiviewer
User Manual
About this Manual
Thank you for purchasing a Grass Valley multiviewer product which contains an MV-8 Series 
Multiviewer. This user manual describes how to configure and operate the MV-8 Series 
Multiviewer within an MV-8X0/8X1 Multiviewer product.

If you have any questions regarding the installation and setup of your product, please contact 
Grass Valley Customer Support.

Related Documents
The following Grass Valley manuals are related documents: 

MV-8 Series 
Multiviewer

Video

Video walls

Related Document Description

User Manual: Orbit - Introduction A general introduction to Orbit and its 
applications.

User Manual: Orbit for Multiviewers Describes multiviewer-specific details of Orbit.

User Manuals:

MV-800 Multiviewer,
MV-820 Multiviewer,
MV-821 Multiviewer,
MV-830 Multiviewer,
MV-840/850 Multiviewer.

Describes physical and format-specific details of 
MV-8X0/8X1 Multiviewer products.

User Manual: RollCall V4 Suite & RollCall Lite Describes RollCall Suite of software control and 
monitoring tools.

User Manual: RollCall Control Panel Describes RollCall Control Panel software.
iii



Notices
iv



Table of Contents
MV-8 Series Multiviewer   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i
Patent Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ii
About this Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iii

1 Product Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Features of MV-8 Series Multiviewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2
New in MV-8 Series Multiviewer Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

V3.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3
Earlier Versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

Order Codes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4
Software Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4
MV-8 Series Multiviewer Architecture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5

Input Processing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
HDR Input Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
Media Biometrics on Inputs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Control and Monitoring. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
MV-8 Series Multiviewer Set up  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
Video Wall Design with GV Orbit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
GV Orbit Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

Terminology  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

2 Booting and Splash Screen  . . . . . . . . . . . . . . . . . . . . . . . . . 9
Booting Up. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9
The Start-up Splash Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

3 Control Screens (RollCall Templates) . . . . . . . . . . . . . . . . . 11
Control Screen Banner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Control Screen Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
System Box. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
NTP Status Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Settings Changes and System Reset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
System-Setup Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

“System Reset” box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
“Product” box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
“Network Settings” box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
“NTP Servers” box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
“Router Controller Settings” box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
“RollCall Settings” box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
“Output Format” box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
“Reference Input” box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
“Streamed Output” box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Multicast Group Addresses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
“Information” box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
SNMP Managers box. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
v



Table of Contents
SNMP Community Strings box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
System Reset to Implement Settings Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Video Alarms Control Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Audio Alarms Control Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Reference Alarms Control Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Ancillary Alarms Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Layout Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Overlays. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
TSL Control Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
GPIO Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
LTC Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Timer Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Timer Request Protocol Control Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Biometrics Setup Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
HDR Setup Control Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Audio Codec Select Control Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

4 H.264 Input-Copy Streams  . . . . . . . . . . . . . . . . . . . . . . . . 47
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Control Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Stream URLs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Stream IP Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Viewing H.264 Input-Copy Streams  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Media Player Example  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Step 1: Prepare Multiviewer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Step 2: View in a Media Player  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

GV Orbit Client Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Set up A Multiviewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
GV Orbit Custom User Panel Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
GV Orbit Lite Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

5 HDR Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Dynamic Range Conversions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Control Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Nits  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

6 Media Biometrics Support . . . . . . . . . . . . . . . . . . . . . . . . . 65

7 Extended Data Services Support . . . . . . . . . . . . . . . . . . . . 67
XDS Data and RollCall Commands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
On-Screen Example. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

8 Output Embedded Audio Support . . . . . . . . . . . . . . . . . . . 71
Orbit and Output Embedded Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

9 Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Default IP Addresses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
vi



MV-8 Series Multiviewer
User Manual
Hardware Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Step 1: Initial RollCall Control Panel Connection and Unit Configuration . . . . . . . . . . . . . 75

Step 1.1: Prepare Computer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Step 1.2: RollCall Control Panel Connection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Step 1.3: Initial Multiviewer Unit Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Step 2: Further Unit Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Step 2.1: Connecting into House System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Default Video Wall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Identifying Display Outputs and Video Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Step 2.2: Further Unit Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Step 3: Orbit Multiviewer Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
STEP 3.1: Pull the Orbit Multiviewer Project from the Unit . . . . . . . . . . . . . . . . . . . . . . 84
STEP 3.2: Quick Edit of Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
STEP 3.3: Push a Project from Orbit to a Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Pull a Project into Orbit from a Unit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

10 Multiviewer Video Wall . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Basic Video Wall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Configuring Alarms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Unit Alarms  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Input Alarms  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Setting Up Alarms on One Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Copying Alarms Settings from Selected Input to All Inputs. . . . . . . . . . . . . . . . . . . . 100

TSL Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
TSL Protocol Tally Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Step 1: Specifying Multiviewer TSL Tally Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Step 2: Specifying Index Parameters for each UMD in Orbit. . . . . . . . . . . . . . . . . . . . 102

Orbit UMD Properties - TSL Protocol Version 3.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Orbit UMD Properties - TSL Protocol Version 5.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

11 Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Licensing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

License Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
License Installation Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Stage 1: Add License to RollCall Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Stage 2: Install License on the MV-8 Series Multiviewer. . . . . . . . . . . . . . . . . . . . . . . . 107

Software Upgrade Package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Software Upgrade Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Stage 1: Add Upgrade Package to RollCall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Stage 2: Install the Upgrade on the MV-8 Series Multiviewer  . . . . . . . . . . . . . . . . . . 111

Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Appendix A MV-8 Series Multiviewer Specification . . . . . . . 117
Video Inputs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Multiviewer Monitoring and Alarms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Video Wall Screen Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
Software Versions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Appendix B XDS Data Types Supported . . . . . . . . . . . . . . . . 123
Program Identification Number (Scheduled Start Time) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
vii



Table of Contents
Length / Time-in-Show  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Program Name (Title) (V Chip Label). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Program Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Content Advisory (V Chip Rating)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Program Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Network Name (Affiliation). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Call Letters (Station ID) and Native Channel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Time of Day . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Local Time Zone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Appendix C SNMP Support  . . . . . . . . . . . . . . . . . . . . . . . . . 127
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
MIB Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
MV-8 Series Multiviewer MIB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

mvStatus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
mvAlarms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
mvControl  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
mvEvents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

Appendix D MV-800-DT Option . . . . . . . . . . . . . . . . . . . . . . 133
Overview of MV-800-DT Orbit Option  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
Orbit Software Installation for Multiviewer Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

License Server Preparation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Configuration Stages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
PC Video Wall  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Configure Multiviewer for MV-800-DT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
LAN System Set Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

Configure Orbit Project for MV-800-DT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Orbit Project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Orbit License Option Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Orbit Video Option Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
Orbit Launch Option Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Video Wall and Video Sources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Auto-Tile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Create a User Variable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Custom Tile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

Launching Orbit Video Wall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Running Orbit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Orbit Window Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
Switching into Design Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Appendix E License Installation for Orbit . . . . . . . . . . . . . . . 155
Install License Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Lock Code for License Host PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
Add Orbit License to License Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

Appendix F VLC Video Stream Player Installation  . . . . . . . . 163
Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
viii



MV-8 Series Multiviewer
User Manual
Appendix G Multiviewer Terminology . . . . . . . . . . . . . . . . . 165

Appendix H Quick Start New MV-8 Series MV with GV Orbit 169
New MV-8 Series Multiviewer Video Wall (Default) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
Edit Video Wall Layout and Configure Alarms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170

Step 1: View MV-8 Series Multiviewer Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Step 2: Pull Default Layout from New MV-8 Series Multiviewer  . . . . . . . . . . . . . . . . 170

GV Orbit Project Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Step 3: Make Changes to the Wall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

A Visible Change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Enable an Alarm. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Step 4: Push the Modified Project back to the Multiviewer  . . . . . . . . . . . . . . . . . . . . 171
Step 5: Visible Alarm Warnings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Contact Us  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Grass Valley Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
Corporate Head Office . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174
ix



Table of Contents
x



Product Overview
The MV-8 Series Multiviewer is the multiviewer “engine” within the Grass Valley MV-8X0/8X1 
Multiviewer product range. Various video input and video wall output signal types are 
supported by the product range. 

This user manual describes the MV-8X0/8X1 Multiviewer product range’s common core 
multiviewer features and includes the features of V3.0 MV-8 Series Multiviewer software. (For 
descriptions of each specific MV-8X0/8X1 Multiviewer product, please refer to its 
corresponding user manual.)

Fig. 1-1: MV-8 Series Multiviewer

MV-8 Series 
Multiviewer
Issue 1 Revision 3 Page 1 © 2020 Grass Valley, a Belden Brand



Features of MV-8 Series Multiviewer
An MV-8 Series Multiviewer can provide up to 12 multiviewer head display outputs, displaying 
video tiles from 48 video inputs. Video wall layouts from multi-channel quad-splits to flexible 
multi-tile screens are available.

Features of MV-8 Series Multiviewer
An MV-8 Series Multiviewer is found in MV-8X0/8X1 Multiviewer products and for all product-
specific information, please refer to the respective product user manual (for example, MV-821 
User Manual).

Video Inputs: 
• 48 multiviewer video inputs.
• HDR support per input and output.
• Media biometrics support per input.

Up to 12 head display outputs: 
• 3G 1080p or HD 720p head display outputs with embedded audio.
• 4K UHD support with four head display outputs used together as quad-link.
• Four head display outputs on a baseline MV-8 Series Multiviewer model. 

More head display outputs enabled with licenses.
• Video walls designed with the GV Orbit Client software tool.

Screen layout flexibility:
• Additionally display web pages, automation play lists, device status screens etc.
• Display status and alarms from external devices.
• Drag and Drop objects onto the screen layout and tailor custom on-screen functionality.
• Adjustable layering, transparencies and fine-positioning.

Flexible alarm capability:
• Monitoring of video, audio and metadata, with alarm notifications.
• Intelligent monitoring of external devices, with configurable on-screen alarms.
• Control and acknowledgment of alarms from hardware- and soft-panels.

H.264 Streaming out of MV-8 Series Multiviewer ‘Input-copies’:
• Extend and expand monitoring with this licensed option. 
• MV-8 Series Multiviewer inputs may be scaled and compressed to create H.264-encoded 

copies which can then be streamed out over an IP connection. 
Note: An MV-8X1 unit requires a ‘H.264 stream’ license.

• Viewable on a desktop PC with Grass Valley’s GV Orbit software or older Orbit Client 
software. 
2



MV-8 Series Multiviewer
User Manual
New in MV-8 Series Multiviewer Software

V3.2
New features in software V3.2 include:

Earlier Versions
Features in software V3.0 include:

Input-copy - scaled/compressed H.264 streams for monitoring (See H.264 Input-Copy Streams, on page 47.)

High dynamic range (HDR) input/output support. (See HDR Support, on page 63.)

High dynamic range (HDR) input support. (See HDR Support, on page 63.)

Media Biometrics Generators on a per input basis. (See Media Biometrics Support, on page 65.)

CC.608 extended data services (XDS) support. (See Extended Data Services Support, on page 67.)

User-defined names for multiviewer video walls/layouts. (See Layout Control Screen, on page 29.)

Embedded audio on multiviewer head display outputs. (See Output Embedded Audio Support, on page 71.)

SNMP Community Strings user-definable. (See SNMP Community Strings box, on page 22.)
3



Order Codes
Order Codes

Software Compatibility

 Table 1-1:   Order Codes MV-8 Series Multiviewer

Order Code Description

Products: For specific MV-8X0/MV-8X1 product order codes/licenses, refer 
to the corresponding multiviewer user manual.

Licenses: A license comprises a code to enable more functionality.

 Head outputs: Enables more multiviewer head display outputs (output 5 
onwards).

Note: SFPs for extra head display outputs must be ordered 
separately.

MV-8XX-OP56 ‡ License to enable outputs 5 and 6.

MV-8XX-OP78 ‡ License to enable outputs 7 and 8. 

MV-8XX-OP910 ‡ License to enable outputs 9 and 10. 

MV-8XX-OP112 ‡ License to enable outputs 11 and 12.

 Input-Copies:

MV-8X1-H264 Enables H.264 streaming out of scaled, H.264-encoded 
multiviewer input-copies. (‘H.264 Stream’ license.)

Note: This is a factory-installed option on MV-821.

‡ See the corresponding MV-8X0/8X1 Multiviewer product user manual for the 
respective output license name.

 Table 1-2:   Software Compatibility  

Software Version

MV-8 Series Multiviewer 3.0.13 or later

RollCall Control Panel 4.19.0 or later

Orbit Client

GV Orbit Client

3.1.15 or later

4.0.0 or later
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MV-8 Series Multiviewer Architecture
The MV-8 Series Multiviewer is found in the MV-8X0/8X1 Multiviewer  range, which covers a 
multiplicity of products, including multiviewers that are integrated into routers, in standalone 
boxes, and/or have video IP input capabilities. Figure 1-2 identifies the MV-8 Series Multiviewer 
“engines” found in MV-8X0/8X1 Multiviewer functional block diagrams.

Fig. 1-2: MV-8 Series Multiviewers in MV-8X0/8X1 Multiviewer Products:
a) MV-800.
b) MV-820/821.
c) MV-830.
d) MV-840/850.

a) MV-800

c) MV-830 d) MV-840/MV-850

MV-8 Series Multiviewer shown in MV-8X0/8X1 Multiviewer product 
functional block diagrams

b) MV-820/821
5



MV-8 Series Multiviewer Architecture
Fig. 1-3: Block Diagram of MV-8 Series Multiviewer

Figure 1-3 shows a simplified block diagram of the MV-8 Series Multiviewer. The main inputs 
and outputs of the MV-8 Series Multiviewer come from or go to the MV-8X0/MV-8X1 product 
and comprise: 

• 48 Video Inputs.
• Video Reference Timing.
• Up to 12 Multiviewer Head Display Outputs.
• Control and Monitoring.

Each video input is processed and then re-sized. There is one re-sizer (scaler) per input. 

Each multiviewer head display image is composited from re-sized video images, rendered 
graphical images and text.

Note: Each one of the 48 re-sized (scaled) inputs may appear any number of 
times on any head display output but with the same re-sizing.
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Input Processing
Each video input undergoes the same processing. Processing includes:

• Status.
• HDR input support.
• Media biometrics.

Additionally, a copy of each video input can be sent to an H.264 scaler/encoder on the MV-8X0/
MV-8X1 product and H.264-encoded, scaled-down copies of the video inputs are available as 
video streams. 

HDR Input Support 
The MV-8 Series Multiviewer supports HDR video inputs. Each multiviewer input has a 
selectable video dynamic range converter (HDR to SDR) which can handle different opto-
electrical transfer functions (OETFs) and color space for HDR video inputs. 

(See HDR Support, on page 63.)

Media Biometrics on Inputs
The MV-8 Series Multiviewer supports media biometrics on video inputs for media assurance. 
Each multiviewer input has a media biometrics generator which generates signatures for the 
input video and for the input audio. The media biometrics generators are fully compatible with 
Grass Valley’s Media Assurance SigMA platform.

(See Media Biometrics Support, on page 65.)

Control and Monitoring
The control and monitoring interface is connected to one or more Ethernet network interfaces 
on the MV-8X0/MV-8X1 product. It is used for:

• control and monitoring; 
• software upgrades and licensing;
• all RollCall messaging; and 
• pushing/pulling video wall designs (Orbit multiviewer projects).

Note: An MV-8X1 requires a ‘H.264 stream’ license, for example, MV-821-
H264.

Note: Licensing for MV-821 products involves factory-fitted H.264 encoder 
modules.
7



MV-8 Series Multiviewer Set up
MV-8 Series Multiviewer Set up 

Getting Started
For getting started instructions for MV-8 Series Multiviewers, see Getting Started, on page 73.

Hardware Installation:

Hardware installation is described in the user manual for the respective MV-8X0/MV-8X1 
product. 

Multiviewer:

Initial multiviewer configuration and set up is done via Grass Valley’s RollCall Control Panel 
application and the multiviewer’s control screens (see Control Screens (RollCall Templates), on 
page 11).

Video Wall:

Video wall design and management is done via the GV Orbit Client application software using 
an Orbit multiviewer project.

Video Wall Design with GV Orbit
The layout and style of video walls are designed with the GV Orbit Client software application: 
Wall designs are stored as individual projects (GV Orbit multiviewer projects), which are then 
pushed to an MV-8X0/MV-8X1 unit, for use by the MV-8 Series Multiviewer ‘engine’ inside. 

Multiple wall layout designs may be generated and stored on a PC. Different wall designs can 
then be pushed to the multiviewer unit for various multiviewer applications.

There are two operating modes for the GV Orbit Client software when used for multiviewer 
projects: 

• Design Mode - GV Orbit ‘Design Mode’ enables wall designs to be generated and pushed 
to each multiviewer.

• Run Mode - In GV Orbit’s ‘Run Mode’ , live video streams may be monitored and alarms can 
be monitored on a PC. 
(Note: Such streaming from an MV-8X1 unit requires a ‘H.264 stream’ license.)

GV Orbit Projects
The GV Orbit project home screen shows a ‘Project Name’, which is treated as an identifier by 
GV Orbit. The name may be changed with the ‘Edit Name’ control in the home screen.

Projects with the same name are considered to be the same and GV Orbit warns the user if 
there are any differences between a project in GV Orbit and the same-named project on a 
multiviewer device. Such differences must be resolved.

Terminology
See Multiviewer Terminology, on page 165 for some multiviewer terminology and its meaning.

Note: If using the older Grass Valley Orbit application (rather than the 
newer Grass Valley ‘GV Orbit’ application), then Orbit requires an 
MV-800-DT license to be able to view live video streams in Run 
Mode.

Note: Use a different and unique GV Orbit project name for each multiviewer.
Rename a default project that has been pulled from a multiviewer.
8
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Booting and Splash Screen
Booting Up .............................................................................................................................  page 9
The Start-up Splash Screen ..............................................................................................  page 10

An MV-8 Series Multiviewer shows a splash screen on its outputs while booting (starting up).

Booting Up
The MV-8 Series Multiviewer boots up after power is applied to the MV-8X0/MV-8X1 unit or 
after a system reset (for example, a system reset instigated from RollCall Control Panel). 

Booting takes about 1 to 2 minutes to complete. Approximately 1 minute after starting to boot 
up, each of the multiviewer’s head display outputs presents a gray start-up splash screen, see 
Figure 2-1.

Note: Initially, the first few lines of text appear, followed by the remaining lines of text. 

Fig. 2-1: MV-8 Series Multiviewer Multiviewer Gray Start-up Splash Screen Example

 Table 2-1:   Module Boot-up Time

Operation Duration

Multiviewer Boot-up Up to 2 minutes

Note: If the MV-8X0/MV-8X1 product’s front main module does not have a flashing “CPU 
Heartbeat” LED when it has finished booting, contact Grass Valley Support. 
Issue 1 Revision 3 Page 9 © 2020 Grass Valley, a Belden Brand



The Start-up Splash Screen
When the MV-8 Series Multiviewer has finished starting up, the start-up splash screen goes 
away (and the green CPU Heartbeat LED on the front main module begins to flash). The 
multiviewer has booted up and the head display outputs show multiviewer video walls 
belonging to the GV Orbit (or Orbit) multiviewer project being used by the multiviewer.

The Start-up Splash Screen 
The start-up splash screen shows some MV-8 Series Multiviewer and MV-8X0/MV-8X1 product 
information about the multiviewer unit, see Figure 2-2. 

Fig. 2-2: Example Start-up Splash Screen Information 

(2) Software version

(4) Firmware version

(5) Display output showing the splash screen.

(3) FPGA number supplying splash screen (Engineering use)

(1) Multiviewer unit serial number

(11) RollCall+ Domain number (12) Unit’s RollCall+ address

(6) Multiviewer Control 
Network Interfaces

(7) (8) (9) (10)

(7) IP Address

(8) Sub-net Mask

(9) Network link status:

• up - network link working

• down - network link not working

• invalid - no network SFP fitted

(10) IP Address type:

• static

• DHCP

Note: Use the ‘1G1’ multiviewer network interface when performing the 
initial unit configuration with Grass Valley RollCall Control Panel.

Note: The ‘Eng’ interface is a reserved internal IP network interface, do not 
use this IP address.
10



Control Screens (RollCall Templates) 
Control Screens (RollCall Templates)
Control Screen Banner ......................................................................................................  page 12

Control Screen Selection ........................................................................................  page 12
System Box ................................................................................................................  page 13
NTP Status Box .........................................................................................................  page 13

Settings Changes and System Reset ..............................................................................  page 13
System-Setup Control Screen ..........................................................................................  page 15

“System Reset” box ..................................................................................................  page 17
“Product” box ............................................................................................................  page 18
“Network Settings” box ..........................................................................................  page 18
“NTP Servers” box .....................................................................................................  page 19
“Router Controller Settings” box ..........................................................................  page 19
“RollCall Settings” box ............................................................................................  page 19
“Output Format” box ..............................................................................................  page 20
“Reference Input” box .............................................................................................  page 20
“Streamed Output” box ..........................................................................................  page 20
“Information” box ....................................................................................................  page 21
SNMP Managers box ...............................................................................................  page 22
SNMP Community Strings box .............................................................................  page 22
System Reset to Implement Settings Changes ..................................................  page 22

Video Alarms Control Screen ...........................................................................................  page 23
Audio Alarms Control Screen ...........................................................................................  page 24
Reference Alarms Control Screen ...................................................................................  page 26
Ancillary Alarms Control Screen .....................................................................................  page 27
Layout Control Screen .......................................................................................................  page 29

Overlays .....................................................................................................................  page 31
TSL Control Screen ..............................................................................................................  page 33
GPIO Control Screen ...........................................................................................................  page 34
LTC Control Screen .............................................................................................................  page 35
Timer Control Screen .........................................................................................................  page 37
Timer Request Protocol Control Screen .........................................................................  page 38
Biometrics Setup Control Screen .....................................................................................  page 39
HDR Setup Control Screen ................................................................................................  page 41
Audio Codec Select Control Screen ................................................................................  page 44

This section describes the control screens (RollCall templates) of an MV-8 Series Multiviewer. 

Following initial configuration of the multiviewer, the control screen may then be used to 
configure and control various operational multiviewer items, including:

• selection of video wall layouts; 
• monitoring alarm status; 
• acknowledging alarms; and 
• control of timer widgets on the video wall.
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Control Screen Banner
Control Screen Banner
Several MV-8 Series Multiviewer control screens are available. The upper, ‘banner’ section of 
each control screen is the same, see Figure 3-1.

Fig. 3-1: Control Screen Upper ‘Banner’ Section 

Control Screen Selection
MV-8 Series Multiviewer control screens may be selected from the Selection box in any control 
screen:

A control screen may be accessed quickly from any of the control screens by right-clicking 
anywhere in a control screen and then selecting a control screen name in the full list that 
appears.

Selection box System box NTP Status box

Banner section

• System - Setup: See System-Setup Control Screen on page 15

• Video Alarms:  See Video Alarms Control Screen on page 23

• Audio Alarms:  See Audio Alarms Control Screen on page 24

• Reference Alarms: See Reference Alarms Control Screen on page 26

• Ancillary Alarms: See Ancillary Alarms Control Screen on page 27

• Layout:  See Layout Control Screen on page 29

• TSL:  See TSL Control Screen on page 33

• GPIO: See GPIO Control Screen on page 34

• LTC: See LTC Control Screen on page 35

• Timer Control: See Timer Control Screen on page 37

• Timer Request Protocol: See Timer Request Protocol Control Screen on page 38

• Media Biometrics: See Biometrics Setup Control Screen on page 39

• HDR Setup: See HDR Setup Control Screen on page 41

• Audio Codec Selection: See Audio Codec Select Control Screen on page 44
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Fig. 3-2: Full List of MV-8 Series Multiviewer Control Screens

System Box
A control screen’s System box (see Figure 3-1) displays the multiviewer system status at the 
top of each control screen: 

• OK - the multiviewer is working correctly. 
• Fail - the multiviewer has a problem. 
• Restart Required - the MV-8 Series Multiviewer requires a restart. (This is indicated for 

some configuration changes which require a restart before the change takes effect.) 

NTP Status Box
A control screen’s NTP Status box (see Figure 3-1) displays the status of the multiviewer’s 
network time (network time protocol, NTP) at the top of each control screen.

Settings Changes and System Reset
Settings changes can be done at any time. But settings changes done in the System-Setup 
control screen will need a ‘System Reset’.

Settings changes outside of the System-Setup control screen do not require a system reset to 
be carried out. These settings include:

• Video alarms - See Video Alarms Control Screen on page 23
• Audio alarms - See Audio Alarms Control Screen on page 24
• Reference alarms - See Ancillary Alarms Control Screen on page 27
• Ancillary data alarms - See Ancillary Alarms Control Screen on page 27
• Layout settings - See Layout Control Screen on page 29
• TSL settings - See TSL Control Screen on page 33
• GPIO settings - See GPIO Control Screen on page 34
• LTC settings - See LTC Control Screen on page 35
• Video wall timer control - See Timer Control Screen on page 37
• Timer Request Protocol - See Timer Request Protocol Control Screen on page 38
• Media Biometrics - See Biometrics Setup Control Screen on page 39

Right-click on a control screen to see this list;
then click on a control screen name to access the control 
screen.
13



Settings Changes and System Reset
CAUTION 
Some System-Setup control screen changes may affect the MV-8X0/8X1 
Multiviewer unit’s network operation.

IMPORTANT 
A System Reset of the multiviewer is required after settings changes are 
made in the RollCall System-Setup control screen.

Such a reset will affect all MV-8X0/8X1 Multiviewer product’s connections, 
including the multiviewer outputs. See “System Reset” box, on page 17.

When the MV-8 Series Multiviewer has re-booted, the new settings will be 
adopted.
14



MV-8 Series Multiviewer
User Manual
System-Setup Control Screen 

The System-Setup control screen (see Figure 3-3) comprises various information boxes which 
display basic information about the multiviewer, for example, system status, product name and 
software version. It is also used to setup the following system details:

• Networking.
• NTP servers.
• Router controller addresses.
• RollCall settings.
• Multiviewer monitor output format.
• Multiviewer name. 
• Multiviewer Input H.264 streaming out.
• SNMP settings.

Note: The multiviewer must be System Reset for any saved setting changes 
to take effect, “System Reset” box, on page 17.
15



System-Setup Control Screen
Fig. 3-3: Multiviewer System-Setup Control Screen 
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“System Reset” box
This box contains a System Reset button which resets (reboots) the MV-8 Series Multiviewer 
Multiviewer. This is used to make any System-Setup control screen configuration setting 
changes take effect. Performing a system reset makes the multiviewer use the new settings. 

A system reset reboots the multiviewer by effectively powering it down and then powering it 
back up: This will interrupt and produce a picture disturbance on all MV-8 Series Multiviewer 
multiviewer outputs.

Once all changes in the System-Setup control screen have been done, carry out a system 
reset: 

1 Click on the System Reset button.
2 Then click on the Confirm button to perform a system reset. 

Or click the Cancel button to abort the system reset.

See Booting and Splash Screen, on page 9, for more information on module booting.

Fig. 3-4: System-Setup Control Screen Boxes

Product box
see “Product” box, 
on page 18

System Reset box
see “System Reset” box, on page 17

Network Settings box see “Network Settings” box, on page 18

NTP Servers box see “NTP Servers” box, on page 19

Router Controller Settings 
see “Router Controller Settings” box, on page 19

Streamed Output box
see “Streamed Output” box, on page 20

Output Format box
see “Output Format” box, on page 20

Reference Input box
see “Reference Input” box, on page 20

Information box
see “Information” box, on page 21

RollCall Settings box
see “RollCall Settings” box, on page 19

SNMP Managers box
see SNMP Managers box, on page 22

SNMP Community Strings box
see SNMP Community Strings box, on page 22

SNMP panes

IMPORTANT A system reset of the multiviewer will affect all outputs. 
17



“Product” box
“Product” box
Displays multiviewer details:

• Product - The name of the MV-8X0/8X1 Multiviewer product containing the MV-8 Series 
Multiviewer. 

• Serial Number - The serial number of the product. 
• Software Version - The currently installed software version number. 
• Build Number - The currently installed software build number. 
• FPGA Version - The currently installed FPGA firmware version number. 

“Network Settings” box
The Network Settings area of the System - Setup control screen shows the MAC addresses and 
any network interface bonding status of each of the MV-8 Series Multiviewer IP network 
interfaces and is used to set the network details for each of the MV-8 Series Multiviewer IP 
interfaces. 

Network interfaces covered:
• 2-off 1G Ethernet interfaces (“1G1”, “1G2”). 

 (MV-8 Series Multiviewer default IP addresses are given the respective MV-8X0/8X1 
Multiviewer product user manual.)

• 1-off “Eng” Interface”, default IP address 10.54.31.224.
 (Reserved for Grass Valley engineering use.)

Enter all the network interface details in the text boxes: 
• IP Address - Set the interface IP Address. 
• Subnet Mask - Set the interface Subnet Mask. 
• Default Gateway Address - Set the interface Gateway address. 
• MAC address - Displays the IP interface MAC address. 
• DHCP - Enabled check box:

• Select to automatically set the IP address details from the network DHCP server.
• Leave box deselected to use the entered IP address settings.

• DNS Server - Set the primary and secondary DNS server IP addresses.

Note: “S” and “P” buttons - 
After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally 
save the new setting. Do this for each text box. 
(Note: Clicking on the “P” button will return the setting to its preset 
default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

Note: The IP address details are only used when the corresponding “DHCP 
Enabled” box is deselected. 

Note: At the next System Reset, the MV-8 Series Multiviewer will adopt all 
the locally saved settings. 
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“NTP Servers” box
Up to four NTP (Network Time Protocol) server URLs or IP addresses can be configured. 
The NTP servers are used to synchronize clocks displayed on multiviewer video walls with the 
specified NTP server.

• NTP Server Address - Enter the NTP server address in the text box and click on the S 
button to save the new setting. Do this for each address entered.

“Router Controller Settings” box 
A Grass Valley router frame may provide input video to a multiviewer; the router will have a 
main router controller and possibly a backup controller. The IP address and IP port details of 
both router controllers are set up in this box: Port details must correspond to port settings in 
the router configuration. 

This allows a multiviewer to display source tallies for the video inputs being displayed by the 
multiviewer and also to control router crosspoints when necessary.

For the main router controller and for the backup controller, enter
• IP Address - Set the router controller IP address. 
• IP Port - Use the default controller IP port number, unless the port has been changed on 

the router controller. 
Click on the P button to return the setting to its default value, if required.

Enter the source name length (number of characters): 
• 4, 8, 12, 16 or 32.

“RollCall Settings” box
The RollCall settings are used to allow Orbit Client software applications to control the MV-8 
Series Multiviewer and should normally be changed if you have multiple MV-8 Series 
Multiviewer units on the same RollCall network.

 

• RollCall Network - Displays the RollCall address, which may not be changed. 
It is not an IP network address.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

Note: A RollCall address has the form: NNNN:UU:PP 

where:
 NNNN is the RollCall network number.
 UU is the RollCall unit number.
 PP is the multiviewer input number (01, 02 etc).
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“Output Format” box
• RollCall Unit - Set the RollCall unit number. The unit number must be unique for each 
Multiviewer being configured. The initial default value is “01”.

• RollCall Port - Displays the RollCall port number. 
• RollCall IP Port - IP port number used by RollCall messages. This can usually be left to its 

displayed value. 
• Domain ID - RollCall+ uses the concept of domains to partition a RollCall network. Only 

those RollCall-enabled devices on the same RollCall+ Domain can communicate with one 
another. A domain is uniquely identified with a Domain ID number. Domain ID is also 
used by Orbit software when connecting to an MV-8 Series Multiviewer.

• The Domain ID can typically be left at its default value, 100. 
(This default value is reserved for multiviewer RollCall traffic.) 

• To reset the Domain ID to the default value of 100 click on the P button. 
• To set the Domain ID, enter the Domain ID number in the text box and click the S 

button to locally save the new setting.
• Ethernet Interface - Set which multiviewer IP interface to use for RollCall messages. The 

selected interface must be connected to the network.

“Output Format” box
MV-8 Series Multiviewer multiviewer head display outputs can be 1080p or 720p.

The Output Format setting sets the format and frame rate for all of the multiviewer head 
display outputs. All outputs share the same format and timing.

“Reference Input” box 
Set which router/unit reference input is used by the MV-8 Series Multiviewer to synchronize its 
head display outputs to. Select reference source from the drop down list. Settings choices are:

• Reference IP 1. (Rear panel analog reference input 1.)
• Reference IP 2. (Rear panel analog reference input 2.)
• Reference IP 3. (Rear panel analog reference input 3, on router-integrated multiviewers.)
• Reference IP 4. (Rear panel analog reference input 4, on router-integrated multiviewers.)
• Free Run.

Note: On the MV-820/821-IP products, there is only one rear analog reference input.

“Streamed Output” box
The Streamed Output settings box contains details about the ‘H.264 streaming’ out of 
multiviewer video input-copies. (This is a licensable codec option on MV-8X1 multiviewer units 
- ‘H.264 stream’ license option - and with factory-fitted hardware being required for the MV-
821.) 

Note: When changing output format, an Orbit multiviewer project change is 
required. 

Note: When driving a 4K monitor, each MV-8 Series Multiviewer multiviewer 
head display output drives one quadrant of the 4K monitor. 

Some 4K monitors have four 1080p inputs, so they can be fed 
from four MV-8 Series Multiviewer 1080p outputs. If this is not the 
case, a separate adapter must be used to convert four MV-8 Series 
Multiviewer multiviewer head display outputs to a single 4K signal 
suitable for the monitor. 
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Multiviewer video inputs are scaled-down (to standard definition size) and streamed out as 
multicast H.264-compressed copies of each input, one RTSP stream per multiviewer video 
input.

• Ethernet Interface - Select Ethernet interface, port 1 (1G1) or port 2 (1G2). 
This setting must be the same as the RollCall Ethernet Interface setting in the RollCall 
box of the System-Setup control screen.

• IP Port - Typically, use the default value.
• Multicast Group Base Address - The base IP address for multicast Streamed Output. 

Enter an IPv4 IP address in the range: 232.0.0.0 to 232.255.255.207. 
Click “S” to save a new setting.

If left blank, then a multicast base address will be chosen randomly from the range 
232.0.0.0 to 232.255.255.207.

(See Multicast Group Addresses, on page 21 for more details about the base address and 
multicast addresses used.)

• Enable - Check box. Select to enable streaming out of the H.264 input-copies.

Multicast Group Addresses
The multicast group addresses used for Streamed Output will be sequential, starting at the set 
base address. There is one H.264-encoded input-copy stream per multiviewer video input. 
For example:
 input 1 stream uses 232.0.0.0; 
 input 2 stream uses 232.0.0.1; 
 input 3 stream uses 232.0.0.2; and so on up to
 input 48 stream uses 232.0.0.47 .

A Multicast Group Base Address configured on the System-Setup control screen must be 
within the allowed IPv4 range (232.0.0.0 to 232.255.255.207).

If the Multicast Group Base Address field on the System-Setup control screen is left blank, 
then a base address is automatically randomly chosen from the IP address allowed range 
232.0.0.0 to 232.255.255.207 . 

Define a Multicast Group Base Address for:
• An installation which requires particular multicast IP addresses to be used.
• Installations with more than one MV-8 Series Multiviewer device on the network.

“Information” box
This box contains text fields which can be set up by the user, enabling the user to enter name, 
location and notes about their multiviewer unit.

Note: A Multicast Group Base Address in the range 
232.0.0.0 to 232.255.255.207 will use the ‘Source-Specific 
Multicast’ assigned local host address block, 232/8, for the 
multicast addresses.

Note: If there is more than one MV-8XX device is on the network, then 
it is recommended that specific Multicast Base Addresses are 
set up in the control screen of each MV-8XX device.

Explanation: 
If Multicast Group Base Address is left blank, then it is 
automatically randomly chosen. In this case, there is a small 
chance that different multiviewers may use some or all of the 
same multicast addresses for H.264 streamed outputs.
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SNMP Managers box
To enter/modify text in the text box, type directly into the editable text field and click the S 
button. To return to the default text, click the P button.

• Name - A meaningful name may be given to the multiviewer unit, making it easier to 
identify. 
 Maximum 32 characters. 
 Remember to press S or press return to save the name locally.

• Location - Multiviewer location details may be entered, to make it easier for the user to 
locate the multiviewer. 
 Maximum 64 characters. 
 Remember to press S or press return to save the name locally.

• Notes - Extra user information about the multiviewer may be entered. 
 Up to 64 characters can be displayed in the notes field.
 Remember to press S or press return to save the name locally.

SNMP Managers box
This box contains IP addresses of all SNMP manager devices. 
Enter each IP address.

SNMP Community Strings box
This box lists the SNMP community strings for SNMP Get, Set and Trap message types. 
Enter the strings for each SNMP message type

System Reset to Implement Settings Changes
After all System-Setup control screen settings changes have been made, an MV-8 Series 
Multiviewer System Reset is required. See “System Reset” box, on page 17.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).
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Video Alarms Control Screen
The Video Alarms control screen allows the user to:

• See the state of alarms related to the video picture for each MV-8 Series Multiviewer input 
• Acknowledge alarms. 

The MV-8 Series Multiviewer input video number is selected by the Video Input Selection 
drop-down menu box. See Figure 3-5.
 

To acknowledge an alarm, select the corresponding Alarm Ack check box on the right-hand 
side of the control screen.

Note: Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the Orbit Client software 
application.

Fig. 3-5:  Video Alarms Control Screen

 Table 3-1:   Video Alarms

Alarm Description

Blackish Detection Active when the video picture is detected to be black or 
nearly black.

Stillish Detection Active when the video picture is detected to have no 
motion present.

Freeze Detection Active when the video picture is frozen.

Input Signal Detection Active when no input signal is detected.

Input Format Change Detected Active when a change of video format is detected at an 
input. For example, from 1080p to 720p.

Video Input Selection
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Audio Alarms Control Screen
Audio Alarms Control Screen
The Audio Alarms control screen allows the user to:

• See the state of alarms related to embedded audio channels accompanying the video 
picture for each multiviewer input. 

• Acknowledge alarms.

Figure 3-6 on page 25 shows the Audio Alarms control screen. 

The video input number is selected by the Video Input Selection drop-down menu box. 

There are 32 audio channels per video input, i.e. 16 stereo pairs. 
Audio channels, or channel pairs, are selected with the Audio Channel Selection pull-down 
box, in groups of eight (i.e. channels “1 to 8”, “9 to 16”, “17 to 24” and “25 to 32”). 

To acknowledge an alarm, select the corresponding Alarm Ack check box on the right-hand 
side of the control screen.

Audio alarms may operate on a per audio channel or channel-pair basis.

Note: Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the Orbit Client software 
application.

 Table 3-2:   Audio Alarms

Alarm Channel or Channel-pair Description

Audio Level per channel The following audio level conditions are detected: 
Silence and Over range.

AC3 Presence per channel Checks for the presence of AC3 encoded compressed 
audio data. 
Use this if AC3 audio data is expected on the channel.

Dolby E Presence per channel-pair Checks for presence of Dolby E encoded compressed 
audio data. 
Use this if Dolby E audio data is expected on the channel-
pair

PCM Presence per channel-pair Checks for the presence of PCM encoded (uncompressed) 
audio data. 
Use this if PCM audio data is expected on the channel-pair.

DialNorm Under per channel-pair Checks audio normalization levels.

Dolby E Config Changed per channel-pair Checks for a change in Dolby E configuration.
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Fig. 3-6:  Audio Alarms Control Screen
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Reference Alarms Control Screen
Reference Alarms Control Screen
The Reference Alarms control screen allows the user to see the state of and to acknowledge 
MV-8 Series Multiviewer alarms relating to loss of input reference and to genlock source.

To acknowledge an alarm, select the corresponding Alarm Ack check box on the right-hand 
side of the control screen.

Fig. 3-7:  Reference Alarms Control Screen 

Note: Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the Orbit Client software 
application.

Note: To see the ‘Reference Input Lost’ (REFERENCE_1_STATE) and the 
‘Genlock Source’ (GENLOCK_1_STATE) alarm states in the Reference 
Alarms control screen, the corresponding ‘Unit Alarms’ in the Orbit 
multiviewer project running on the multiviewer must be enabled.

Otherwise, the alarms’ states are shown as: ‘-’
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Ancillary Alarms Control Screen
The Ancillary Alarms control screen allows the user to see the state of alarms and to 
acknowledge alarms related to the ancillary data for each multiviewer input.

All alarms sourced by the multiviewer can be monitored by GV Orbit and are available to a 
RollCall LogServer.

Fig. 3-8:  Ancillary Alarms Control Screen

1. Select Video Input channel being shown. 2. Acknowledge an alarm by selecting the corresponding 
Alarm Ack check box on the right-hand side of the control 
screen.

 Table 3-3:   Ancillary Data Alarms

Video Alarm Description

CC1 Lost, CC2 Lost, CC3 Lost, CC4 Lost Loss of Closed Caption data

T1 Lost, T2 Lost, T3 Lost, T4 Lost Loss of Teletext data.

XDS Lost Loss of Extended Data Service information.

V-Chip Lost Loss of V Chip content rating information.

TSID Lost Loss of Transport Stream ID information.

CC608 Lost Loss of Closed Caption EIA 608 information.

DTVCC(608) Lost Loss of DTV Closed Caption EIA 608 data.

DTVCC(708) Lost Loss of DTV Closed Caption EIA 708 data.

VITC Lost Loss of Vertical Interval Time Code information.

OP42 Lost Loss of OP42 Closed Caption information. 

OP47 Lost Loss of OP47 Closed Caption/Subtitling information. 

SMPTE2010 Lost Loss of SMPTE 2010 data.
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Ancillary Alarms Control Screen
Note:
Alarms can be viewed and acknowledged on this control screen.

Multiviewer alarms are set up with the Orbit Client software application.
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Layout Control Screen 
Video walls are designed with the Orbit Client software tool. A wall may have one or more 
layout (alternative layouts) which may be selected.

The Layout control screen allows the user to select which wall layout to apply to each video 
wall on one or more multiviewer head display outputs. (Alternatively, a Grass Valley soft-panel 
or hard-panel may also select wall layout, via the RollCall protocol)
Additionally, the on-screen transition type between one wall layout and the next can be set up.

The layouts are all contained within an Orbit multiviewer project which is pushed to the 
multiviewer unit.

The control screen also enables an output overlay feature to be enabled, which show 
information about the multiviewer inputs on the output screen and about the head display 
outputs themselves.

In an Orbit multiviewer project:
• Each video wall has a name property in the Orbit Client, set to “Wall 1”, “Wall 2” etc. by 

default. 
The wall name may be edited in Orbit Client by the user. It is shown on the Layout control 
screen. 

• Each wall layout has a name property in Orbit Client, set to “Layout1”, “Layout2” etc. by 
default. 
This layout name is editable in Orbit Client by the user. It is also reflected on the Layout 
control screen.

 
Note: These names are case-sensitive.
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Layout Control Screen
On the Layout control screen, there is a Wall pane per video wall defined in the Orbit project. 
See Figure 3-9.

Fig. 3-9: Layout Control Screen: a) Layout Control Screen; b) In Orbit.

 Table 3-4:   Wall Pane Settings  

Wall 1 ... up to Wall 12 Description

Wall N: Wall number, as defined in the Orbit multiviewer project. 
(1 ... up to 12.)

Wall name Wall name, as defined in the Orbit multiviewer project.

Outputs Head display output number(s) associated with the wall.

Layout Drop-down box. 
Select the wall layout to use from the drop-down list.

 Table 3-5:   Layout Transition Settings  

Setting Description

Layout Transition:

Wall pane

Applicable head display output(s)

Layout selection 
drop-down box

Wall name

Layout name

a) Layout Control Screen

b) In Orbit - Wall names, Layout 

Layout name

Wall names
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Overlays
Overlays can be enabled on the head display outputs which show information about 
multiviewer inputs in video tiles on multiviewer outputs and about the head display outputs 
themselves.

In particular, the Output Overlay feature briefly shows extensive information after the Output 
Overlay feature is enabled. This includes IP addresses of the MV-8X0/8X1 Multiviewer.

Fade Through Black Check box. 
Controls the type of on-screen transition seen when changing 
between wall layouts.

• Select for fade down to black, then fade up to new layout.
• Deselect for a cut from current to new wall layout.

 Table 3-5:   Layout Transition Settings  (continued)

Setting Description

 Table 3-6:   Overlay Settings  

Setting Description

Wall Designer Mode Overlay Information:

Controls the display of overlay information on each multiviewer 
head display output. See Figure 3-10.
(Multiviewer software 2.16.16 or later.)

Identify Inputs Check box. 
Select to display overlay information which identifies each video 
input on each video tile on the head display output screen.

Identify Outputs Check box. 
Select to display overlay information which identifies each head 
display output screen (1 ... up to 12). The overlay appears in the 
bottom right-hand side of each output.
Check box. 
Select to display overlay information which identifies each head display output screen (1 ... up to 12). The overlay appear in the bottom right-hand side of each output.

• Immediately after this Identify Output feature is enabled, 
the overlay information shown about the outputs is 
extensive. 

om right-hand side of each output.
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• After 20 seconds, the overlay then reverts to showing only 
brief output information, as shown in Figure 3-10.

Fig. 3-10: Multiviewer Head Display Output with Example Input and Output Overlays

 Table 3-6:   Overlay Settings  (continued)

Setting Description

Identify Outputs: Overlay identifies 
multiviewer display output

Identify Inputs: Overlay identifies a video 
input in a multiviewer video wall tile
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TSL Control Screen
The TSL control screen allows the user to select settings related to MV-8 Series Multiviewer 
support of the TSL protocol. 

TSL protocol is supported in TSL Server Mode or TSL Client Mode, see Multiviewer Video Wall, 
on page 95, Figure 10-5 on page 101.

For two types of Ethernet protocols (UDP and TCP), the user can separately set up IP address 
and network port information.

Remember to press the S button.

Fig. 3-11: TSL Control Screen

 Table 3-7:   TSL Mode Settings

Setting Description

UDP:

Ethernet Interface Drop-down box. Select port 1 (1G1) or port 2 (1G2).

3.1 Port Text box. Network port to receive TSL 3.1 messages on. 
 Enter the network port number. 

5.0 Port Text box. Network port to receive TSL 5.0 messages on.
 Enter the network port number.

Mode Drop-down box. Select ‘Server’ mode, or ‘Disabled’.

TCP:

IP Address Text box.

In Server Mode: 
Enter local IP address of the MV-8 Series Multiviewer.

In Client Mode: 
Enter IP address of TSL Controller.

3.1 Port Text box. Network port to receive TSL 3.1 messages on. 
 Enter the network port number.

5.0 Port Text box. Network port to receive TSL 5.0 messages on.
 Enter the network port number.

Mode Drop-down box. 
Select ‘Server’ mode, ‘Client’ mode or ‘Disabled’.
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GPIO Control Screen
The GPIO control screen allows the user to set up settings related to the MV-8 Series 
Multiviewer unit’s GPIO interface. 

There are four GPIO ports, 1 to 4, on a MV-8X0/8X1 Multiviewer product. For connector pinouts, 
see the respective MV-8X0/MV-8X1 product user manual.   

Fig. 3-12:  GPIO Control Screen

 Table 3-8:   GPIO port Settings.

Setting Description

GPIO 1 to GPIO 4:

Enabled Check box. 
Select to enable the GPIO port on the MV-8 Series Multiviewer unit.

Direction

Input 

Output

Radio buttons. 
Select the GPIO port to be an input or an output.

Selected: GPIO port is an input.

Selected: GPIO port is an output.

Active State

High

Low

Radio buttons. 
Select the active state of the GPIO port. 

Selected: Active state of the port is a high voltage.

Selected: Active state of the port is a low voltage.
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LTC Control Screen 
The LTC control screen allows a user to select an LTC source for the MV-8 Series Multiviewer 
multiviewer.

The following LTC sources may be selected:
• From Multiviewer.
• From Router.

See Table 3-9.

Note: This control screen is not applicable to standalone multiviewer 
products (which are not integrated into a router frame).

Fig. 3-13:  LTC Control Screen 

 Table 3-9:   LTC Source Radio Button Options  

Setting Description

LTC Source Radio buttons to select source of LTC for MV-8 Series Multiviewer.

From Multiviewer When selected, use the LTC signal applied to the multiviewer 
module rear panel.

From Router When selected, use the LTC information from the host router 
frame.

See Note 1.

Note 1: The host router’s controller configuration must have
 EmbeddedTimecodeEnable set to ‘True’. 

This is set in the Grass Valley WorkBench router configuration 
tool. Configuration item = 

Controller > Devices > LocalRouterDevice > 
LocalRouterConfig > EmbeddedTimecodeEnable

See Figure 3-14.
35
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Fig. 3-14: EmbeddedTimecodeEnable Router Controller LTC Source Configuration Item

(WorkBench tool screenshot)
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Timer Control Screen
The Timer Control screen allows a user to set up timers used in widgets on a video wall and 
then remotely control the timers. Timers may also then be remotely started or stopped 
controlled with RollCall soft-panels or hard-panels.

 

Remember to press the S button.

Note: All Timer widget styling and configuration of trigger points etc. are 
set through the Orbit application.

Fig. 3-15:  Timer Control Screen

 Table 3-10:    Timer Control Settings

Setting Description

Timer 1 to Timer 16:

Running Check box. 
Select to start the timer. Deselect to stop.

Reset Check box. 
Select to reset the timer. The check box automatically is deselected 
when the timer has reset.

Text box Enter the timer’s target time. Target time format: HH:MM:SS
For example, 12:30:00

Note: When the target time is changed, the timer is reset. 

Count Up Radio button. 
Select to reset the timer and count up.

Count Down Radio button. 
Select to reset the timer and count down.
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Timer Request Protocol Control Screen 
The Timer Request Protocol control screen allows a user to define the IP address of an 
“eTimer” server device and the IP port number to use. 
The protocol used is the PluraTM timer request protocol.

 

Remember to press the S button when changing the IP Address settings.

Fig. 3-16:  Timer Request Protocol Control Screen 

 Table 3-11:    Timer Request Protocol Settings

Setting Description

IP Address Enter IP Address of an ‘eTimer’ server device.

Port Enter IP port number to use for Timer Request Protocol messages.

Enabled Check box. 
Select to enable use of Timer Request Protocol messages.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

Note: Configuring a Timer Widget for eTimer:

A Timer widget is configured on a video wall tile with the Orbit 
Client application. It can be configured to be connected to an 
eTimer service.
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Biometrics Setup Control Screen 
The Biometrics Setup control screen sets up the multiviewer’s media biometric generators 
(MBGs) on a per multiviewer input basis. Each of the 48 inputs has an MBG which can produce 
a video and audio signature from the media at the corresponding input. 

Each multiviewer input’s MBG is separately configurable and is assigned a name on a per input 
basis which is user-editable. The name identifies a signature when it is checked and verified 
(media assurance). 

 

Fig. 3-17:  Media Biometrics Control Screen 

 Table 3-12:    Media Biometrics Settings  

Setting Description

Domain ID RollCall domain ID for media biometrics signature messages.

Domain ID Text box.
Enter RollCall+ domain ID. Press S to save value.

Note 1: Set the Domain ID to be the same as the one used by the 
media assurance system, for example Grass Valley SigMA.

Note 2: Use a different Domain ID value from the RollCall Settings 
domain ID, set up in the System-Setup Control Screen. 
(See “RollCall Settings” box on page 19.)

Generator Setup

Active Video Displays which video inputs have media biometrics generators 
(MBGs) enabled. 

Video Input 
Select

Check box. 
Select the video input to configure. 
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Biometrics Setup Control Screen
Enabled Check box.
Select to enable the MBG at the selected input. 

Name Text box.
Name for the media biometrics generator (MBG) at the selected 
input. Defaults to the video input name, e.g. ‘Video Input 6’. 
The name is user editable.

Enter a unique name for the MBG if required. Press S to save the 
value.

Note: A name identifies a signature’s video input source, useful in a 
media assurance system.

Audio Channels Check boxes for audio channels 1 to 32.
Select the audio channel signatures required.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

 Table 3-12:    Media Biometrics Settings  (continued)

Setting Description
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HDR Setup Control Screen
The HDR Setup control screen sets up the multiviewer’s HDR/SDR conversions on a per 
multiviewer video input or per head display output basis. Each of the 48 inputs has a HDR-SDR 
conversion block which can convert an HDR input into an internal SDR signal. Each of the 12 
head display outputs has an SDR-HDR conversion block which can convert a the internal SDR 
output signal to HDR for output. 

Fig. 3-18: HDR Setup Control Screen

Each of the 48 video inputs may be set up individually or all together (ganged). See Figure 3-
19a and b.

Each of the 12 head display outputs may be set up individually or all together (ganged). See 
Figure 3-19c and d.
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Fig. 3-19: HDR Setup Controls: 
a) Video Inputs.
b) Ganged.
c) Head Display Outputs.
d) Ganged.

a) Video Input HDR Settings b) Video Input HDR Settings (Ganged)

c) Head Display Output HDR Settings d) Output HDR Settings (Ganged)

 Table 3-13:   HDR Setup Settings  

Setting Description

Inputs: Configure settings for each input here.

Gang Check box.
Select to setup up HDR on all inputs together.

LUT Drop-down box.
Select dynamic range of video input.

Primary Drop-down box. 
Select the color space of the video input.
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Nits Text box. 
Enter the Nits value for the HDR to SDR conversion.

See Nits, on page 64, for information about this setting.

Outputs: Configure settings for each output here.

Gang Check box.
Select to setup up HDR on all outputs together.

LUT Drop-down box.
Select required dynamic range of head display output.

Primary Drop-down box. 
Select the required color space of the head display output.

Nits Text box. 
Enter the Nits value for the SDR to HDR conversion.

See Nits, on page 64, for information about this setting.

Note: “S” and “P” buttons - After entering information in each text box, 
always click on the adjacent “S” button or press “return” to locally save 
the new setting. Do this for each text box. (Note: Clicking on the “P” 
button will return the setting to its preset default value).

“S” - Locally save new setting value (or press “return”).

“P” - Locally save default setting value.

 Table 3-13:   HDR Setup Settings  (continued)

Setting Description
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Audio Codec Select Control Screen
The Audio Codec Select control screen selects optional audio channel(s) to be compressed for 
each ‘input-copy’ RTSP stream. The audio stream and the corresponding input video H.264-
compressed stream are wrapped into a RTSP stream. (Requires the ‘H264 stream’ license.)

This feature applies to MV-8X1 multiviewer products only.

For each of the 48 video inputs, a mono audio channel can be selected from the first 8 stereo 
audio pairs. This can be the left- or right-audio channel of the pair, or a stereo down-mix.

Fig. 3-20: Audio Codec Select Control Screen

Note:
A mono audio can be set up for each multiviewer video input. Settings are for 
the 48 inputs. They do not reflect any quad-link input associations that might 
be applied in the multiviewer.
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Fig. 3-21: Audio Channel Selection

1 De-select to enable the audio codec for this 
audio channel.

2 Select stereo pair.

3 Select audio from the pair:
• Stereo (i.e. a down-mix);
• Left; or 
• Right.
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H.264 Input-Copy Streams
Section contents:
H.264 Input-Copy Streams
Introduction .........................................................................................................................  page 48
Control Settings ..................................................................................................................  page 49

Stream URLs ..............................................................................................................  page 49
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Viewing H.264 Input-Copy Streams ...............................................................................  page 50
Media Player Example ............................................................................................  page 50
GV Orbit Client Examples .......................................................................................  page 52

This chapter describes an MV-8 Series Multiviewer’s H.264 ‘input-copy’ feature. 

Note:
An MV-8X1 multiviewer requires a ‘H.264 stream’ license. For example, 
license ‘MV-821-H264’.
A MV-821 multiviewer requires a factory-fitted hardware option.
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Introduction
Introduction
The MV-8 Series Multiviewer supports sending out H.264-compressed copies of video inputs 
on a control network interface for displaying on a PC screen as a simple confidence monitor 
facility using Grass Valley’s GV Orbit Client application (product: GV Orbit Lite). 

Each MV-8 Series Multiviewer video input image is scaled-down and compressed to create an 
H.264-encoded ‘input-copy’ stream. For each input, an audio channel can also be selected and 
compressed into an accompanying audio stream. The image and audio streams are transmitted 
on a control network interface of the multiviewer unit. They are transmitted as an RTSP stream 
and may be viewed on a PC for thumbnail/confidence monitoring applications.

Fig. 4-1: Multiviewer Video Input-Copy RTSP Streams

Each RTSP stream is a wrapper for:
• an H.264-compressed image stream; and 
• an optional (compressed) mono audio channel selected from audio channels of the video 

input. (MV-8X1 multiviewers only.)

Note: Audio only available in MV-8X1 multiviewers.

Note:
MV-8 Series multiviewers can potentially source an RTSP ‘Input-Copy’ H.264 
video stream for each multiviewer video input. 
In practice, in order to minimize image artifacts for real-world video signals, 
it is recommended a maximum of 30 streams is sourced from any one 
multiviewer.
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Control Settings
The following ‘Input-Copy’ stream settings are defined on the System - Setup control screen, 
see System-Setup Control Screen, “Streamed Output” box, on page 20:

• Ethernet interface to use.
• IP port number.
• Specific Multicast Group Base Address, if required.
• Global-enable of all streams.

Audio channel selection is done in the Audio Codec Select Control Screen, on page 44. For 
each video input, a single mono audio channel can be selected to be either:

• any left- or right-audio channel; or 
• a down-mix of any stereo pair. 

Stream URLs
Each stream has the same stem URL and video inputs 1 to 48 have suffices ‘/Stream1’ to ‘/
Stream48’ respectively.
For example: 

Stream IP Ports
An IP Port number is defined in the System-Setup Control Screen, “Streamed Output” box, on 
page 20. For example, 8554. The IP Port number used for H.264 ‘input-copy’ streams is different 
between MV-8X0 and MV-8X1 devices:

• For MV-8X0 multiviewers - The defined IP port number is used for all 48 streams. 
For example, 8554.

• For MV-8X1 multiviewers - The defined IP port number is used for the first 12 streams; for 
the next 12 streams, the IP Port number used is incremented by one; and so on. 
For example: 

rtsp://10.162.51.200:8554/Stream10

IP Address   IP Port number   video input 10 suffix

Streams IP Port

1 - 12 8554

13 - 24 8555

25 - 36 8556

37 - 48 8557
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Viewing H.264 Input-Copy Streams

Media Player Example
To view an H.264 ‘input-copy’ stream in a media player:

Step 1: Prepare Multiviewer 
1 License the MV-8X1 multiviewer device for H264 streaming.
2 Apply video inputs to the multiviewer unit.

In the multiviewer’s System-Setup control screen, in the Streamed Output section:
3 Select the Ethernet Interface to use for the streams.

Fig. 4-2: Streamed Output Settings

4 Leave IP Port number at its default (8554), 
unless the port number needs to change for some reason.

5 Leave the Multicast Group Base address blank,
unless a specific base address is required.

6 Select Enable.

All H.264 stream outputting is enabled. 

All multiviewer RTSP H.264 ‘Input-Copy’ streams are now ready to be sent out. A stream is only 
sent out when another device/application (for example, a media player) has opened the RTSP 
stream for viewing.

Step 2: View in a Media Player
1 Open the media player of choice. VLC is used in this example.
2 Open the RTSP media stream on the network.

Fig. 4-3: Open Media Stream

Note: 
H.264 ‘input-copy’ streams are only sent when a device is receiving the 
RTSP stream.

Enter URL of stream. 
For example,
RTSP://10.162.51.166:8554/Stream48

Click Play.
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3 Click Play.

The media is shown in the player window.

Fig. 4-4: Playing H.264 ‘Input-Copy’ Stream

Fig. 4-5: Codec Information
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GV Orbit Client Examples
To view an H.264 ‘input-copy’ stream in a video tile in GV Orbit Client, a video tile on a GV Orbit 
screen needs setting up to show streamed video from some URL.

For this, the following must be known:
• IP address of the multiviewer.
• The IP port number(s) it is using for its H.264 ‘input-copy’ streams.

The client PC being used must have network access to the RTSP stream source device.

Set up A Multiviewer
See Step 1: Prepare Multiviewer, on page 50 to set up a multiviewer for ‘Input-Copy’ streaming.

GV Orbit Custom User Panel Example
This example will describe how to view an H.264 ‘Input-Copy’ stream on a custom user panel. 
This is for a GV Orbit Professional or Enterprise user. To run a GV Orbit custom user panel, a GV 
Orbit system is required with a GV Orbit server:

1 Open GV Orbit Client.
2 Create a new ‘C&M’ project.
3 Create a new screen. 

This will be the custom user panel.

Note: The GV Orbit Client should be in ‘Design Mode’ (see tool bar icon in Figure 4-6).
4 Click once on the Video Stream widget icon at the bottom of the screen, see Figure 4-6.

Then move the cursor to bring a Video Stream widget onto the custom user panel. 
Position the widget on the panel and click once to release it.

Fig. 4-6: Adding Video Stream Widget

Click once on Video Stream icon. Note: Icon shows ‘Design Mode’.

Bring a Video Stream widget 
onto the custom user panel
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5 Select the widget on the panel and edit the Video > Source Path widget property: 
Enter the RTSP stream URL. (See Figure 4-7.)

Fig. 4-7: Enter URL for Video > Source Path Property

6 Click the ‘Run Mode/Design Mode’ tool bar icon. See Figure 4-8.

The custom user panel is run and video appears as a live thumbnail image in the widget. 
See Figure 4-8.

Fig. 4-8: Run Custom User Panel

Enter H.264 stream URLVideo > Source Path property

‘Run Mode/Design Mode’ Tool Bar Icon (showing ‘Run Mode’)
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GV Orbit Lite Example
For GV Orbit Lite product users, there is just the GV Orbit Client tool, no GV Orbit server nor 
C&M project. The example uses just the GV Orbit Client tool and is also applicable to the GV 
Orbit Professional and Enterprise products. 

The example below will build a small desktop video wall and configure one tile to show an 
H.264 stream.

Step 1: A Simple Desktop Video Wall
1 Run GV Orbit Client and create a New Project, a multiviewer project.

.

Fig. 4-9: Creating a New Multiviewer project

2 Click Next.
.

Fig. 4-10: Creating a New Multiviewer project

3 Select ‘Output Size’ 1920x1080.
And click OK.

4 Click the Walls icon and click New Wall. See Figure 4-11.
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Fig. 4-11: Creating a New Wall

5 Enter a Name for the new wall.
Click OK.

A new video Wall is shown.
6 Click the Run Mode/Design Mode tool bar icon to set GV Orbit Client into ‘Design Mode’. 

(Note: Clicking this icon toggles between the two modes.)

The new video wall is shown in the Wall Editor. See Figure 4-12.
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Fig. 4-12: New Wall in Wall Editor

7 Click the ‘Assign Outputs to Wall’ button ( ) in the bottom right-hand corner. 
8 Click on the 3x3 Grid to populate the new video wall with a 3x3 grid.

.

Fig. 4-13: Setting a 3x3 Grid in Wall Editor

Run Mode/Design Mode icon, showing GV Orbit Client in ‘Design Mode’.

Assign Outputs 
to Wall button

Assign Outputs 
to Wall button

Click on a 3x3 
grid
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9 Select a video tile on the Wall.
10 Find the Streaming Video property and set it to ‘True’.
.

Fig. 4-14: Streaming Video True

11 Click the Save Project icon in the tool bar ( ) to save the Wall design.

The basic preparation of a simple desktop video wall is done and is now saved. One video tile 
on the wall has been set up for displaying RTSP ‘Input-Copy’ video stream.

Step 2: Point GV Orbit Client at a Multiviewer

To point the GV Orbit Client multiviewer project at a multiviewer unit:
12 Click Multiviewer -> Properties in the main menu.

The Properties dialog is shown. See Figure 4-15.

Streaming 
Video property 
value set to 
True

Selected Tile
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Fig. 4-15: Properties Dialog

In the Properties dialog:
13 Enter the IP address of a multiviewer sourcing H.264 ‘Input-Copy’ streams.
14 Click Apply.

A connection is made to the multiviewer device and this is indicated at the bottom of the 
GV Orbit Client screen. See Figure 4-16.

.

Fig. 4-16: Properties Dialog

Some further multiviewer settings are then filled out automatically in the dialog. 
(E.g. RollCall Network, Domain ID and Routing Service address.)

15 In the ‘Streamed Output’ section of the Properties dialog (see Figure 4-15):
1 Enter the IP address of the network interface used by the multiviewer for the H.264 

Input-Copy streams.
2 Enter the IP port number used by the multiviewer for the H.264 Input-Copy streams.

16 Click OK.

A dialog pops up advising that the ‘Streamed Output’ changes mean the Wall editor will 
need to be closed (so any unsaved Wall design needs saving first). 

Properties DialogClick Multiviewer -> Properties

IP address of multiviewer

‘Streamed Output’ section

Note: The Wall design has already been saved in the steps above. 
If it had not been, then the new Wall design would be lost.

Connection to Multiviewer
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Fig. 4-17: Properties Dialog Pop-up

17 Click Yes.

The Wall Editor is closed and the multiviewer property settings are applied to the GV Orbit 
project and the multiviewer ‘Input-Copy’ stream URLs are formed.

Step 3: View the Video Wall

Re-Open the Wall:
18 Click on the Walls icon 

and select the new wall design in the list.
.

Fig. 4-18: Re-Open Wall

The wall design is opened in ‘Run Mode’. One video tile shows video from a RTSP video 
stream. See Figure 4-19.

Pop-up
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Fig. 4-19: Wall Running and Showing a Video Stream

To change the video input being shown by the video tile:
19 Click the Run Mode/Design Mode icon 

to stop running the wall and show it in the Wall Editor.
20 Select the video tile.
21 Change the Configuration -> Input property in the Properties box to select another 

video input. See Figure 4-20a.

The resulting video stream path is filled out from the video input number selected and the 
IP address/IP port information. See Figure 4-20b.

Run Mode/Design Mode icon
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Fig. 4-20: Select a Video Input:
a) Select video input to show on video tile.
b) Resulting RTSP video stream path.

22 Click the Save Project icon in the tool bar ( ) to save the Wall design.
23 Click the Run Mode/Design Mode icon 

to start running the wall. The newly-selected video is now shown on the screen. See 
Figure 4-21.

Properties box

a) Select video input to show on video tile.

b) Resulting RTSP video stream path.

Note: RTSP video stream path is shown for an MV-8X0 multiviewer. 
An MV-8X1 multiviewer uses one of four IP port numbers, depending 
on the multiviewer video input (see Stream IP Ports, on page 49).
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Fig. 4-21: Wall Running and Showing a New Video Stream

Run Mode/Design Mode icon
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The HDR support at MV-8 Series Multiviewer inputs and outputs is described in this 
section.

Introduction 
An MV-8 Series multiviewer operates with standard dynamic range (SDR) signals internally and 
supports HDR at its video inputs and head display outputs. 

Each multiviewer input supports HDR video input signals: Each input has a dynamic range 
converter which operates on the 10-bit luminance/chrominance values of the input video 
signal and converts from HDR to internal SDR values. The video signal is then re-sized and 
displayed by the multiviewer core etc.

Each multiviewer head display output supports HDR video output signals: Each output has a 
dynamic range converter which operates on the 10-bit luminance/chrominance values of the 
head display output video signal and converts from internal SDR to HDR values. 

Note: For information about high dynamic range video, refer to the 
‘HDR - A Guide to High Dynamic Range Operation for Live 
Broadcast Applications’ white paper on the Grass Valley web 
site (search on ‘HDR’).

Note:
The HDR conversions available on each input and output of the MV-8 Series 
multiviewer efficiently handle video images with an increased luminance 
range., enabling a multiviewer to operate in a mixed SDR and HDR 
environment. 

Note:
Use specialist test and measuring equipment to analyze and monitor the 
dynamic range, color gamut and color primaries of a source video signal.
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Dynamic Range Conversions
Dynamic range conversions use a look-up table (LUT) approach to convert the internal SDR to/
from the following HDR standards:

• Hybrid-Log-Gamma (HLG).
• Perceptual Quantizer (PQ), SMPTE ST2084.
• Sony Slog3.

As part of the HDR to/from SDR conversions, a user-controlled setting (Nits) determines either 
a) how much of the extra dynamic range in an HDR input signal is used in a corresponding 
internal SDR signal; or b) how much of the extra dynamic range in an HDR output signal is used 
for showing the (SDR) multiviewer head display output image.

Additionally, the processing can use the BT.709 color space (as used in SDR) or convert to/from 
the BT.2020 color space (typically used in HDR).

Fig. 5-1: Multiviewer Video Input HDR to SDR Processing

Control Settings
HDR processing on each multiviewer video input or output is set up in the multiviewer’s 
RollCall template (control screen). See HDR Setup Control Screen, on page 41.

Nits
The Nits control sets how much of the extra dynamic range of an HDR input signal is used 
when it is converted to SDR internally for the MV-8 Series Multiviewer. And vice versa for the 
HDR conversion at the head display outputs.

• The nominal Nits value is 100 nits for a normal SDR monitor image.
• For the multiviewer video input HDR conversion:

• Video values outside the Nits range are clipped to their limit in the RGB color space.
• setting the Nits to a higher value results in a darker picture, which may be useful for a 

brighter monitor. 

Note: Video Input Alarms:
The MV-8 Series Multiviewer contains various input alarms (configured with 
GV Orbit) which look at the video input. For a ‘video black’ alarm and an HDR 
input, for example, a ‘video black’ detector looks directly at the HDR video 
input data values (and not at any processed, SDR values). 
All alarm configuration settings must be set accordingly.
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Media Biometrics Support
The integrated media biometrics support at multiviewer inputs is described in this section.

Each multiviewer input supports media biometrics with a media biometrics generator (MBG), 
which produces a low data-rate signature for the respective input video and audio. Up to 48 
signatures can be generated.

Setting up of an MV-8 Series Multiviewer is done via a RollCall template, or control screen, (see 
Biometrics Setup Control Screen, on page 39). Multiviewer inputs can have media biometrics 
generation enabled on a per input basis. Audio channels on each input can be individually 
selected for biometric signature generation. Each input’s MBG can be individually named for 
subsequent easier signature identification.

Signature data for all enabled multiviewer inputs is transmitted onto a selected RollCall 
domain via a ‘control’ Ethernet interface of the MV-8X0/8X1 Multiviewer unit. The signature 
data is compatible with Grass Valley’s SigMA media assurance solution.

Fig. 6-1: Multiviewer Media Biometric Generators (MBGs)

Note: For information about media biometrics, refer to the 
‘Media Biometrics - Analysis, Detection & Reporting Solution for 
Media Workflows’ data sheet on the Grass Valley web site 
(search on ‘media biometrics’).
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Extended Data Services Support 
The extended data services (XDS) support in the MV-8 Series Multiviewer is described in 
this section. 

The MV-8 Series Multiviewer provides access to some of the XDS data on each of its video 
inputs. 

XDS data is extracted from each input and is available externally via RollCall commands. 
Additionally, the data is available internally and XDS data can be used or displayed by the 
multiviewer’s video wall(s).

XDS Data and RollCall Commands
Details of the XDS data types supported and the RollCall command numbers used are 
found in XDS Data Types Supported, on page 123.

On-Screen Example 
This example shows how to access some XDS data on a video input and then display it on a 
multiviewer video wall. This is done by editing the Orbit multiviewer project and cause it to 
read various RollCall commands. 

(The complete list of RollCall commands numbers to access XDS data types is in appendix XDS 
Data Types Supported, on page 123.)

Assumptions
• An MV-8X0/8X1 Multiviewer is running with a known Orbit multiviewer project in a house 

system.
• Multiviewer video input 1 carries XDS data.

Note: For full information about all extended data services, refer to the 
CEA-608-B specification.
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Procedure
Procedure
To display XDS data on the video wall:

1 Open the Orbit multiviewer project.
2 Create a new empty tile.
3 Add two Label widgets.

Fig. 7-1: ‘XDS Labels’ on New Tile

4 Select one Label and click the Edit Behaviours icon (see Figure 7-1) to open the 
‘Behaviours and Bindings’ graphical editor.

5 Add a RollCall+ Command Behaviour to the editor. See Figure 7-2.

Fig. 7-2: Add a RollCall+ Command Behaviour

Edit Behaviours icon

Behaviours and Bindings graphical editor

Added RollCall+ Command Behaviour

Direct Binding added automatically
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6 Double-click on the added RollCall+ Behaviour in the graphical editor to edit the 
Behaviour properties.

7 Set the Command Number property to ‘1600’ . 
(This is the V Chip Label, see to Appendix B XDS Data Types Supported, Program Name 
(Title) (V Chip Label), on page 124.)

Fig. 7-3: Edit Behaviour Properties - Command Number

8 Click Close.
9 Repeat for the other Label, but set its Command Number to ‘1650’ . 

(This is the V Chip Rating, see to Appendix B XDS Data Types Supported, Content Advisory 
(V Chip Rating), on page 124.)

10 Click Close.

This has set up access to XDS ‘Program Name’ (V Chip Label) and XDS ‘Content Advisory’ (V 
Chip Rating) data values from multiviewer input 1 and set up two on-screen Label widgets for 
on-screen display of the values.

For clarity in this example: 
11 Further comments may be added onto the tile using labels, as shown in Figure 7-4.

Fig. 7-4: Comment Labels Added to the Tile

12 Click Save in the main tool bar to save the tile changes.
13 Close the tile tab.
14 Open a Wall and drag on the new tile. See Figure 7-5.
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Fig. 7-5: XDS Labels Tile on Wall

15 Click Save. 
16 Click Save Project.
17 Click the Push icon in the main tool bar to push the project to the MV-8X0/MV-8X1.

The multiviewer unit deploys the project and the XDS data on video input 1 is shown on-
screen. See Figure 7-6.

Fig. 7-6: Deployed XDS Labels Tile
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Output Embedded Audio Support 
The MV-8 Series Multiviewer supports embedded audio on its head display outputs.

Orbit and Output Embedded Audio
The output embedded audio channels are configured in Orbit; stereo audio pairs from any 
multiviewer video input can be selected for each output:

1 Open an Orbit multiviewer project.
2 Click on Multiviewer > Output Audio in the main menu bar.

The Output Audio dialog is shown, see Figure 8-1.

Fig. 8-1: Output Audio Dialog
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Orbit and Output Embedded Audio
3 Set up the audio stereo pair channels for embedding into each multiviewer head display 
output. See Table 8-1.

4 When all embedded output audio stereo pairs are configured, click OK.
5 Click Save Project.
6 Push the project to the multiviewer unit for the output audio settings to take effect.

 Table 8-1:   Output Audio Dialog Settings  

Setting Description

Select Output To select which multiviewer head display output to configure, 
click on an output name in the list (Output 1 to Output 12).

Stereo Output 1 to 
 Stereo Output 8

For each audio stereo pair (1 to 8), select the following:

Input Source Drop-down box.
Select the multiviewer video input (Input 1 to Input 48) required 
to source the audio for the selected output.

Pair Number Drop-down box.
Select which audio stereo pair to use from the input source.
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This chapter describes configuring basic system information for an MV-8 Series Multiviewer in 
and MV-8X0/8X1 Multiviewer product. 
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Introduction
Introduction
MV-8 Series Multiviewer configuration is typically performed once after installation of the 
product and is done using Grass Valley’s RollCall Control Panel tool.

Following an initial configuration step with RollCall Control Panel, the control screens (RollCall 
templates) may then be used to further configure and control various operational multiviewer 
items, including:

• selection of video wall layouts; 
• monitoring alarm status; 
• acknowledging alarms; and
• control of timer widgets on the video wall.

This section describes how to get started with an MV-8 Series Multiviewer multiviewer. These 
instructions are applicable to all MV-8 Series Multiviewers.

Default IP Addresses
Typically, a new MV-8X0/8X1 Multiviewer product will be using default IP addresses on 
Ethernet interfaces, which includes one or more ‘control and monitoring’ interface. 

Hardware Installation

Note: RollCall Control Panel:

The RollCall Control Panel tool is part of the RollCall Suite. (For 
installation instructions, see the “RollCall V4 Suite & RollCall Lite” 
manual.)

Install the RollCall Control Panel software on your computer. 
See the ‘RollCall Control Panel User Manual’ and contact Grass 
Valley Support for information.
Use RollCall Control Panel software version listed in Software 
Versions, on page 122 . 

Note: See the corresponding MV-8X0/8X1 Multiviewer product user 
manual for Ethernet interface descriptions and default IP 
addresses.

Note: Refer to the corresponding MV-8X0/8X1 Multiviewer user manual 
for details about unpacking the product, the unit’s rear connections 
and hardware installation.
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Step 1: Initial RollCall Control Panel Connection and Unit Configuration
Items required:

• A laptop, or some computer, with an RJ45 Ethernet port and with Grass Valley RollCall 
Control Panel installed.

• A ‘direct’ CAT 5 Ethernet cable. 
(Note: Depending on the computer’s network interface, a normal cable may suffice.)

Initial MV-8X0/8X1 Multiviewer connection and configuration should be carried out on a 
separate IT network, separate from any house IT network. The initial configuration sets up MV-
8X0/8X1 Multiviewer product IP addresses and communication settings.

Fig. 9-1: Initial Configuration, separate from House System

Step 1.1: Prepare Computer
To prepare a computer for initial connection:

1 Select which computer Ethernet RJ45 port to use 
and set the port to a fixed IP address on the same network sub-net as the MV-8 Series 
Multiviewer. 

(For example, use 10.54.31.200 for the computer port when connecting to a multiviewer 
default IP address of 10.54.31.221. 
Note: Multiviewer default IP addresses are listed in the ‘Specification’ appendix of each 
MV-8X0/8X1 Multiviewer product user manual.) 

2 Disable any WiFi connections on the computer. 
(These may interfere with the wired RJ45 port.)

3 Directly connect the computer RJ45 port to the chosen multiviewer control Ethernet port 
of the MV-8X0/8X1 Multiviewer product using the ‘direct’ Ethernet cable.

Step 1.2: RollCall Control Panel Connection
When connecting RollCall Control Panel for the first initial MV-8 Series Multiviewer 
configuration, the computer should be connected directly to the MV-8X0/8X1 Multiviewer.

If connecting RollCall Control Panel for further unit configuration, connect to the unit in your 
house system network.

Note: Default IP Address on Ethernet control interface:

Typically, a new MV-8X0/8X1 Multiviewer product has two 
multiviewer Ethernet control interfaces and will be using a 
default IP address, detailed in the respective MV-8X0/8X1 
Multiviewer product user manual.

MV-8 Series 
Multiviewer
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Step 1.2: RollCall Control Panel Connection
To connect RollCall Control Panel to the MV-8 Series Multiviewer:
1 With the computer connected to the 1G Ethernet port of the MV-8X0/8X1 Multiviewer, 

open the RollCall Control Panel application from:

Start > All Programs > SAM > RollCall > Control Panel

The RollCall application starts and the initial RollCall Control Panel template is 
displayed.

2 Click on the Build Network  icon in the RollCall tool bar to display the Build Network 
dialog. See Figure 9-3.

Note: Refer to the corresponding product user manual for the MV-8X0/
8X1 Multiviewer product for details of rear panel Ethernet 
connections.

Fig. 9-2: RollCall Control Panel Initial Screen

Fig. 9-3: Build Network Dialog
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3 Enter your MV-8X0/8X1 Multiviewer ‘MV control’ IP address into the ‘IP Address’ text box 
and click OK to connect to the MV-8X0/8X1 Multiviewer product. 

4 After a short period displaying the message “Connecting”, 
RollCall Control Panel will connect to the MV-8X0/8X1 Multiviewer.

5 In RollCall Control Panel, double-click on an MV-8X0/8X1 Multiviewer product icon or 
name in the left-hand pane. 
(Note: The MV-820-IP shows one multiviewer block and four Video IP blocks in the left-
hand pane. Connect to the multiviewer block in this case.)

Control screen settings are downloaded. 

Note: Default IP addresses for the network interface ports are detailed in the 
respective MV-8X0/8X1 Multiviewer user manual.

Note: The IP addresses of MV-8 Series Multiviewer control Ethernet 
interfaces (used during initial multiviewer configuration) can be 
found by:

• Enabling the Output Overlay feature on head display 
outputs (see Layout Control Screen, on page 29, and 
Overlays, on page 31) to show IP address information briefly 
on the outputs.

Or
• Restart the multiviewer product by re-applying power, 

causing a MV-8 Series Multiviewer reboot. IP address 
information is shown in the monitor splash screen, 
Booting and Splash Screen, on page 9 and its Figure 2-1 on 
page 9.

Fig. 9-4: Connected to MV-8X0/8X1 Multiviewer

Multiviewer unit
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Step 1.2: RollCall Control Panel Connection
6 The MV-8 Series Multiviewer control screens are automatically downloaded and then 
displayed in the pane on the right. See Figure 9-6.

 

RollCall Control Panel has now connected to the unit.

For initial configuration, see Step 1.3: Initial Multiviewer Unit Configuration, on page 79.

Fig. 9-5:  Control Screen Downloading 

Fig. 9-6: MV-8 Series Multiviewer RollCall Control Screens 

Double-click

Downloading...

Selection Box
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Step 1.3: Initial Multiviewer Unit Configuration
(Initial configuration should be carried out on a separate IT network, separate from any house 
IT network.) 

This initial configuration sets up an MV-8X0/8X1 Multiviewer unit’s IP addresses and 
communication settings:

1 Select the System-Setup control screen in the upper Selection box. 
2 Change the settings in the System-Setup control screen. 

a) Under Network Setting, 
set up the Ethernet interface IP network settings relevant to your house network.

b) Under RollCall Settings, set up:
Unit number (must be unique for each unit). and
Domain ID (typically the same for each unit).

Once all setting changes in the System-Setup control screen have been done:
3 Click on the System Reset button at the top of the System-Setup control screen 

(see “System Reset” box, on page 17).
Then click Confirm to perform a system reset. 

When the MV-8X0/8X1 Multiviewer unit has re-booted, the new settings will be adopted. The 
MV-8X0/8X1 Multiviewer can then be connected to your house IT network.

IMPORTANT 
A System Reset of the multiviewer is required before saved 
settings changes in the System-Setup control screen take effect.

Such a reset will affect all MV-8X0/8X1 Multiviewer connections, 
including the multiviewer monitor outputs. See “System Reset” 
box, on page 17.
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Step 2: Further Unit Configuration

Fig. 9-7: Further Configuration - Multiviewer Connected to House System

Step 2.1: Connecting into House System
Following initial configuration, the MV-8X0/8X1 Multiviewer unit can then be connected to 
your house system, including IT network connections and video input/output connections. 

Refer to the corresponding MV-8X0/8X1 Multiviewer user manual for details about unit 
connections and connecting up the unit.

Further configuration can be done via control screens (RollCall templates), as required. Control 
screens for the MV-8 Series Multiviewer are describe in Control Screens (RollCall Templates), on 
page 11.

MV-8 Series 
MultiviewerHouse System

IMPORTANT Ethernet connection:
Check the logical and physical connection of all ‘control and monitoring’ 
Ethernet ports on the MV-8X0/8X1 Multiviewer product’s rear panel. This is 
required for optimum MV-8 Series Multiviewer performance. 

Explanation:

An MV-8X0/8X1 Multiviewer product typically has more than one 
control Ethernet port - for example “1G1” and “1G2”. 
However, if a port is disconnected, its IP address can still be “seen” 
through the other port. This means the MV-8 Series Multiviewer can 
still appear to be operating normally even with one or more 
unconnected control network ports. But there is a performance 
penalty for operating with such an unconnected network port.
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Default Video Wall

By default, after booting up, a new MV-8 Series Multiviewer will display each of the 48 
multiviewer video inputs on a default video wall layout. This done on four multiviewer head 
display outputs (Output 1 to 4), see Figure 9-8.

Identifying Display Outputs and Video Inputs
To help with getting started and with unit system set up, the multiviewer can be configured to 
identify its inputs and outputs with an overlay on each multiviewer head display output. It can 
do this regardless of whether a video input is being supplied. 

1 View the Layout control screen. (See Layout Control Screen, on page 29.)
2 Use the controls to turn on/off the display of overlay information to identify:

• multiviewer inputs; and/or 
• head display outputs. 

See Figure 9-9.

Fig. 9-8: MV-8 Series Multiviewer Default Video Wall on Multiviewer Head Display Outputs 1 to 4 

Video inputs 1 to 48 are shown

Fig. 9-9: Layout Control Screen - Multiviewer Display Output Overlays
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Step 2.2: Further Unit Configuration
Further settings changes can be done at any time. All further MV-8 Series Multiviewer 
configuration settings can then be set up with RollCall Control Panel. However, settings 
changes done in the System-Setup control screen will need a System Reset. See Settings 
Changes and System Reset, on page 13.

CAUTION 
Some System-Setup control screen changes may affect the MV-8X0/8X1 
Multiviewer unit’s network operation.

IMPORTANT 
A System Reset of the multiviewer is required after settings changes in 
the RollCall System-Setup control screen.

Such a reset will affect all MV-8X0/8X1 Multiviewer product’s connections, 
including the multiviewer outputs. See “System Reset” box, on page 17.

When the MV-8X0/8X1 Multiviewer has re-booted, the new settings will 
be adopted.

Note: MV-820-IP: To configure the IP inputs of an MV-820-IP, 
refer to the MV-820 Multiviewer user manual. Specific IP input 
configuration instructions are found in the ‘Getting Started’ chapter.

Note: MV-821-IP: To configure the IP inputs of an MV-821-IP, 
refer to the MV-821 Multiviewer user manual. Specific IP input 
configuration instructions are found in the ‘Getting Started’ chapter.
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Step 3: Orbit Multiviewer Project
After the MV-8 Series Multiviewer unit is configured, the default Orbit multiviewer project may 
be pulled from the unit, modified and pushed back to the unit. This section demonstrates how 
to make a simple and visible change to the video wall. 

The section contains: 

Introduction
This section will:

• Get the Orbit multiviewer project from the MV-8X0/8X1 Multiviewer unit 
(= the default MV-8 Series Multiviewer Orbit project for a new, factory unit).

• Make a simple, visible change to the video wall.
• Push the amended project back to the unit.
• See changed project working on-screen.

And finally, it describes how to:
• Pull a project from a MV-8X0/8X1 Multiviewer unit.

Assumptions
This section assumes that:

• The MV-8X0/8X1 Multiviewer is:
• running;
• connected to a control Ethernet network; and 
• receiving/sending video IP streams.

• IP addresses of the MV-8X0/8X1 Multiviewer Ethernet interfaces are known.
• Orbit is installed on a client computer connected to the control network. (Note: Access to 

an Orbit license is not required for basic Orbit operation.)

Note: For full instruction on creating video walls etc., please refer to 
Orbit documentation.

Introduction, on page 83

STEP 3.1: Pull the Orbit Multiviewer Project from the Unit, on page 84

STEP 3.2: Quick Edit of Project, on page 87

STEP 3.3: Push a Project from Orbit to a Unit, on page 91

Pull a Project into Orbit from a Unit, on page 93
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STEP 3.1: Pull the Orbit Multiviewer Project from the Unit
STEP 3.1: Pull the Orbit Multiviewer Project from the Unit
To get the MV-8X0/8X1 Multiviewer unit’s Orbit multiviewer project:

1 Run Orbit and click File > New project,

Fig. 9-10: Orbit File > New Project

2 Select Connected Multiviewer Project.
3 Browse into a new, empty folder and click Choose.

Fig. 9-11: New Project Dialog - Connected Multiviewer Project

4 Click Next.
All accessible multiviewer devices are auto-discovered and listed.

Note: Auto-discovery of multiviewer devices relies on RollCall+ data 
packets being present on the network. Ensure these are supported 
by the house network system. Contact Grass Valley customer 
support for further information.
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Fig. 9-12: New Project Dialog - Multiviewer List

5 Select a device in the list and click OK.

To enter device details manually, if a device is not listed, then:
6 Click Specify Host and enter the device’s RollCall domain number and IP address.
7 Click Refresh.
8 Select the device in the new list and click OK.

Fig. 9-13: New Project Dialog - Multiviewer List

Orbit connects to the device and pulls the Orbit multiviewer list from the device.
9 At the login dialog, enter the appropriate project Username and Password. 

Note: For a default project on a new, factory unit, this is ‘admin’ and ‘admin’.
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Fig. 9-14: Login Dialog

10 Click Login.

A new Orbit project has been created from the connected multiviewer and opened in Orbit.

Fig. 9-15: Example Project Open in Orbit

To save the project on the local computer in the previously-specified folder:
11 Click File > Save Project in the main menu,

or click the Save Project icon in the main tool bar.

Note: For information about setting up and changing passwords for an 
Orbit project and also about managing Orbit users, see the ‘Orbit 
Introduction’ user manual, ‘Manage Users’ section.

Save Project icon
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STEP 3.2: Quick Edit of Project 
To make a visible change to the project:

1 Click the large Walls icon and select a wall item in the list, for example, ‘Output 1’. See 
Figure 9-18.

The selected wall is opened in a Wall Editor. See Figure 9-19.

Fig. 9-16: Project Open in Orbit

Fig. 9-17: Wall Editor in Run Mode

Clock and Text Label tile
Design Mode icon
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STEP 3.2: Quick Edit of Project
Figure 9-17 shows the Orbit Wall Editor in Run Mode. To perform edits to the multiviewer 
video wall, the Wall Editor must be in Design Mode. 

To change from Run Mode to Design Mode:
2 Click the Design Mode icon in the main menu.(See Figure 9-17.)

Orbit enters Design Mode. See Figure 9-18.

Fig. 9-18: Wall Editor in Design Mode 

3 Double-click on the Clock and Text Label tile.
The tile is opened in the Tile Editor. See Figure 9-19.

Note: Clicking on the Design Mode/ Run Mode icon toggles between 
modes.

Clock and Text Label tile
Run Mode icon
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Fig. 9-19: Tile Editor 

To make a change to the tile:
4 Click on the tile background.
5 In the Properties box, select the ‘Extended Style > Background Color’ property.
6 Click on the   ...    icon to show the Background Color dialog. See Figure 9-20 on page 89.
7 Select a color and click OK.

Fig. 9-20: Color Picked 

Background Color tile property   ...    icon

Color selected

Alpha 255 entered 
(fully opaque)
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STEP 3.2: Quick Edit of Project
8 Click the Save File icon in the main tool bar to save the tile change.

Fig. 9-21: Tile with New Background Color 

9 Click on the  x  on the tile tab to close the tile.
10 Click on the Save Project icon in the main tool bar to save all changes.

Fig. 9-22: Changed Wall 1 

Click to Save File 

Click  x  to close tile
Click to 
Save Project

Click to Save Project
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STEP 3.3: Push a Project from Orbit to a Unit
To push a project from Orbit onto a multiviewer:

1 Open a project in Orbit and click Multiviewer > Properties.
2 Orbit projects store which multiviewer unit they came from.

If the multiviewer details are correct, then proceed; 
however, if the details require changing, enter the target device’s:

• IP address;
• RollCall network number and unit number; and 
• Domain ID. 

Click OK.

Fig. 9-23: Pull/Push Icons and Multiviewer > Properties Dialog

To push a project from Orbit to the device:
3 Click the Push icon in the main menu.
4 Select the project in the Choose Projects dialog (see Figure 9-24) 

and click OK.
The project is pushed to the device.

Pull icon

Push icon Multiviewer details
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STEP 3.3: Push a Project from Orbit to a Unit
Fig. 9-24: Choose Projects Dialog

If the MV-8X0/8X1 Multiviewer unit already has a project of the same name, then a dialog is 
shown (see Figure 9-25a). Click ‘Yes’ to overwrite with the project from Orbit. 

When the push is complete a ‘pushed successfully’ message is shown. See Figure 9-25b. 

Fig. 9-25: Push Messages

The project is now running on the target MV-8 Series Multiviewer. The edited tile background 
color is changed.

Select the Orbit project to push

a) Push Message

b) Push OK.
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Pull a Project into Orbit from a Unit
This may be useful when ‘getting started’: To pull a project into Orbit from a MV-8X0/8X1 
Multiviewer unit:

1 Open a multiviewer project in Orbit and click Multiviewer > Properties.
2 If the multiviewer details require changing, enter the target device’s:

• IP address;
• RollCall network number and unit number; and 
• Domain ID. 

Click OK.
3 Click the Pull icon in the main menu.
4 Select the project in the Choose Projects dialog (see Figure 9-26) 

and click OK.
The project is pulled from the device.

Fig. 9-26: Choose Projects Dialog

5 When the pull is complete a ‘pulled successfully’ message is shown. See Figure 9-27. 

Fig. 9-27: Pull Message

The Orbit project of the same name in as the one pulled from the device has now been 
updated. It is now the same as that on the device.

Select the project to pull
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Multiviewer Video Wall
Section contents:
Multiviewer Video Wall
Basic Video Wall ..................................................................................................................  page 96
Configuring Alarms ............................................................................................................  page 97
TSL Support ........................................................................................................................  page 101

Multiviewer video wall layouts are designed and managed with the Orbit Client application.

Please refer to the published Orbit documentation for instruction about how to use Orbit in 
multiviewer applications.

This manual assumes the reader is familiar with the Orbit software and only outline 
information is given.
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Basic Video Wall
Basic Video Wall
Multiviewer video wall layouts are designed with the Orbit Client application and are called 
‘Orbit projects’. These multiviewer projects can be pushed to a multiviewer to be deployed and 
the video wall can be viewed on monitor displays. 

The form and appearance of a video wall design on a multiviewer device may be changed 
through layouts and themes.

Procedure:

The procedure for video wall design and deployment is similar for Grass Valley’s MV-8 Series of 
multiviewers. For Orbit instruction and details on using Orbit for multiviewer wall layouts, see 
the published “Orbit - Introduction” and “Orbit for Multiviewers” user manuals. A ‘basic video 
wall’ is described in the Orbit documentation and includes:

• Initial Screen Orbit Initial screen.

• New Project Creating a new project: 

Multiviewer Project 

Connected Multiviewer Project

• Existing Project Opening an existing project.

• Recent Projects Opening a recent Orbit project.

• Project Home Screen The Orbit project home screen.

• Basic Wall Using Orbit to create a basic video wall layout for 
an MV-8 Series Multiviewer.

• Wall Layouts Demonstration of different wall layouts within 
the same Orbit multiviewer project.

• Wall Themes Demonstration of applying different themes to 
the same wall layout.
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Configuring Alarms
Alarms can be configured on multiviewer inputs and for the multiviewer unit itself. Alarms are 
set up using the Orbit Client software. When a multiviewer project is open in Orbit, Alarms can 
be set up via the Multiviewer menu bar item.

Unit Alarms
Unit alarms are not related to any one multiviewer input. The configuration dialog is accessed 
in the following way:

1 Click Multiviewer > Unit Alarms.
A dialog box, Figure 10-1, shows the possible unit alarms, see Table 10-1:.

2 Click on an alarm name in the Select Alarm box, to select an alarm.
The corresponding properties are shown. 

3 Unit alarm properties are described in Table 10-2:.  

Fig. 10-1:  Orbit - Multiviewer Units Alarms

 Table 10-1:   Unit Alarms

Alarm Description

Genlock State Detects unlocked multiviewer genlock.

Reference Input Lost Detects a lost reference signal.

 Table 10-2:   Unit Alarms Properties

Alarm Property Description

Alarm Enable Check box. 
Select to enable the alarm.

Delay 
(seconds)

Text box.
The time in seconds from when a fault is detected to when the alarm is displayed on the 
multiviewer video wall. 

Set a small delay to prevent transient alarms being displayed, filtering out transient alarms.

Automatic 
Acknowledgment

Check box. 
Select to enable automatic acknowledgment by the multiviewer system. 

Deselect to manually acknowledge the alarm. Alarms will have to be acknowledged by the 
user, to stop an alarm flashing.

Delay 
(seconds)

text box.
The time in seconds from when the alarm occurs to when it is automatically acknowledged by 
the multiviewer system. 

Set a delay here to allow an alarm to flash and be displayed for a short time before being 
automatically acknowledged.
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Input Alarms
Input Alarms
Various alarms can be set up for each multiviewer input. It is possible to set up alarms on one 
input and then to copy those alarm settings to other inputs.

Setting Up Alarms on One Input
1 Click Multiviewer > Input Alarms.

The Alarms window is shown.
2 Set Selected Input to ‘Input 1’.

Select the Alarm tab.

Figure 10-2 lists the input alarm types.
3 Click on the Video Input Lost alarm name to select it.

The alarm properties appear in the Properties box.
4 Select Alarm Enable.

The alarm name (Video Input Lost) is shown underlined and bold in the list of alarm types, 
indicating the alarm is enabled on the selected input.

Note: Each alarm has its own ‘Alarm Enable’ and ‘Automatic Acknowledge’ 
properties.

Fig. 10-2: Orbit - Multiviewer Alarms window, Alarm tab.

Input 
Alarm 
Types
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5 Select the Audio Level alarm.
Select Alarm Enable.

6 Click on the Levels tab.
The Levels tab allows setting up of some audio levels. See Figure 10-3. 

7 Click on the Audio 1-16 tab or the Audio 17-32 tab.
The Audio Channels tabs (Audio 1-16 and Audio 17-32) allow various audio alarms to be 
enabled on individual audio channels (audio channels 1 to 32 inclusive) relating to the 
multiviewer video input selected. See Figure 10-4.

Note: Each alarm has its own ‘Alarm Enable’ and ‘Automatic Acknowledge’ 
properties.

Note: Some alarms have further settings and parameters; this is indicated by 
text in the properties box.

For example, 
for the Audio Level alarm, the properties box text indicates that 
configuring of levels and channel alarms is done in separate tabs.

Fig. 10-3:  Orbit - Multiviewer Input Alarms window, Levels tab.

Audio 
Levels 
Settings
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Input Alarms
Alarms have now been set up for Multiviewer Input 1 (the Selected Input).

Copying Alarms Settings from Selected Input to All Inputs
To copy the alarm settings of the Selected Input to all other channels:

1 Click on the Input tab.
The Input tab screen is shown.

2 Click Copy All.
The alarm settings of Input 1 have been applied to all multiviewer inputs.

3 Click OK.
The Alarms window closes.

4 Click the File > Save Project, to save the Orbit project so far.

Fig. 10-4:  Orbit - Multiviewer Alarms window, ‘Audio 1 - 16’ tab.

Audio Level 
alarm enabled 
on embedded 
Audio Channels 
1 to 8

Selected 
multiviewer 
Input
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TSL Support

TSL Protocol Tally Settings
TSL protocols are used widely throughout the industry for communication between a TSL Tally 
controller and Under Monitor Displays (UMD’s). The protocol enables tally lamp control and 
text label data to be carried to each UMD device.

A TSL Tally controller handles the tally data in a video system and provides TSL Tally control 
information to each UMD.The MV-8 Series Multiviewer supports two TSL protocols: TSL 3.1 and 
TSL 5.0. Initial TSL support settings are described here.

Setting up the multiviewer to work with a TSL tally-based system involves the following steps:
• Specify how the multiviewer gets the TSL Tally message information.

 See Step 1: Specifying Multiviewer TSL Tally Mode, on page 101.
• Specify index parameters for each UMD on the video wall.

 See Step 2: Specifying Index Parameters for each UMD in Orbit, on page 102.

Step 1: Specifying Multiviewer TSL Tally Mode
The multiviewer may get its TSL Tally information in one of two modes:

a) Server Mode - MV-8 Series Multiviewer listens for Tally messages.
Specify the MV-8X0/8X1 Multiviewer IP address and network port to receive Tally 
messages on.

b) Client Mode - MV-8 Series Multiviewer reads Tally messages from a Tally controller.
Specify the IP address and network port number of the Tally controller.

The Grass Valley RollCall Control Panel application is used to configure the settings for a MV-8 
Series Multiviewer in the RollCall TSL control screen; see TSL Control Screen, on page 33.

Fig. 10-5: TSL Protocol Operating Modes: 
a) Server Mode
b) Client Mode

a) Server Mode

b) Client Mode
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Step 2: Specifying Index Parameters for each UMD in Orbit
Step 2: Specifying Index Parameters for each UMD in Orbit
Use the Orbit Client application to set the properties of each UMD in a video tile on the video 
wall layout. The properties differ between TSL Protocol 3.1 and 5.0.

The style of the UMD widget can be selected with the Preferences > UMD Style property.

The index parameters used by each UMD are specifiable in the UMD properties. Values can be 
set manually or values can be automatically assigned as part of assigning inputs to video tiles. 
(Refer to Orbit documentation.)

Orbit UMD Properties - TSL Protocol Version 3.1
TSL Protocol 3.1 is the original TSL protocol for sending data over a serial comms connection or 
via Ethernet. The multiviewer supports an Ethernet connection. Each multiviewer monitor 
screen is addressed with a Display address. Each UMD widget is associated with a video tile in 
Orbit and must have its 3.1 Display Address property set up.

Fig. 10-6:  Orbit Video Tile - UMD Widget TSL 3.1 Properties

1. Select Video Tile and the video tile properties are shown.

2. Set Preferences > UMD to ‘True’ and UMD properties are shown below. 
(Expand this property item if required.)

3. Set UMD > UMD Protocol to ‘Version 3.1’ 
and UMD > 3.1 Display Address property is 
shown.
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Orbit UMD Properties - TSL Protocol Version 5.0
TSL Protocol 5.0 is a 16-bit protocol, introduced to handle multiviewer display devices over 
Ethernet. It supports ASCII or Unicode character sets, and data is sent as UDP or TCP/IP over 
Ethernet. 

Each multiviewer monitor screen is addressed by a Screen Index and each UMD within it by a 
Display Index. Each UMD widget associated with a video tile must have two parameters set up:

• 5.0 Screen Index - Index number (address) of each display monitor.
(16-bit, $FFFF reserved. 0 = not used.)

• 5.0 Display Index - Index number for each UMD in a display.
(16-bit, $FFFF reserved. 0-based.)

Fig. 10-7:  Orbit Video Tile - UMD Widget TSL 5.0 Properties

UMD enabled

TSL 5.0 properties

Selected Video Tile, Multiviewer Input 9

TSL 5.0 selected
103



Step 2: Specifying Index Parameters for each UMD in Orbit
104



Maintenance 
Maintenance
Licensing .............................................................................................................................  page 105
License Installation Procedure ......................................................................................  page 105
Software Upgrade Package ........................................................................................... page 109
Software Upgrade Procedure ........................................................................................ page 109

This section describes various software maintenance operations for the MV-8 Series 
Multiviewer. These operations are carried out via the control interface of the MV-8 Series 
Multiviewer. Refer to the respective MV-8X0/8X1 Multiviewer user manuals for details about 
the control Ethernet interface to use.

Information about an MV-8 Series Multiviewer’s software version, serial number etc. is 
displayed on the RollCall System - Setup control screen.

Licensing
Licenses give access to additional MV-8 Series Multiviewer features (for example, extra head 
display outputs for an MV-8 Series Multiviewer, or 12G video input capability for an MV-821 
unit).

License Files
The license files for the MV-8 Series Multiviewer are supplied upon purchasing a license from 
Grass Valley. They are small .zip files. 

The license key within the file is tied to the Serial Number of a the main card in an MV-8X0/
8X1 Multiviewer unit, as reported by RollCall. 

License Installation Procedure
The process of adding a license to an MV-8 Series Multiviewer follows the standard process for 
a hardware module with licenses administered by Grass Valley RollCall. 

For more details, please see the Grass Valley ‘RollCall Control Panel User Manual’ or the Grass 
Valley ‘RollMechanic Operator’s Manual’.

For RollCall Control Panel, MV-8 Series Multiviewer license installation is a two-stage process:
• Stage 1: Add License to RollCall Control Panel, on page 106.
• Stage 2: Install License on the MV-8 Series Multiviewer, on page 107.

Note: For a ‘H.264 stream’ license on MV-821 multiviewers, factory-fitted 
codec modules are required.
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Stage 1: Add License to RollCall Control Panel
These are described in the sub-sections below and are applicable to licensing an MV-8 Series 
Multiviewer (or to licensing an MV-820-IP/MV-821-IP product’s video IP block). 

Stage 1: Add License to RollCall Control Panel
The example below uses Grass Valley RollCall Control Panel. See Software Versions, on 
page 122, for the minimum version of RollCall Control Panel to use for the multiviewer device 
being licensed.

1 Run the RollCall Control Panel software.
2 Connect to a MV-8 Series Multiviewer on a MV-8X0/8X1 Multiviewer product unit. 

(Click the  icon and enter the IP address in the Build Network dialog. Click OK.)

Fig. 11-1: Build Network Dialog in RollCall Control Panel Tool

3 Click the Edit Licenses icon  or click Edit > Licenses.
The License Viewer window is displayed.

4 Click on the Multiviewer Licenses tab.
Available licenses in your RollCall Control Panel tool are listed.

To import your license:
5 Click Import Licenses. 

Navigate to the license zip file and select the license file name. 
Click OK.
The license is imported into RollCall Control Panel and is added to the listed licenses. 
See Figure 11-6.

The license is now added to RollCall Control Panel.
106



MV-8 Series Multiviewer
User Manual
Fig. 11-2: Example License Viewer Dialog (An image for MV-821 is shown)

Stage 2: Install License on the MV-8 Series Multiviewer
Once the required license is imported into RollCall Control Panel, the next stage is to install the 
license on the device (MV-8 Series Multiviewer, or MV-8X0/8X1 Multiviewer video IP block etc.).

1 Right-click on the connected Multiviewer block in the left-hand pane of the RollCall 
Control Panel screen. 
Click Unit License.

2 The Unit License window shows current licenses and available licenses. See Figure 11-4.

List of available imported licenses shown in the tab

Import Licenses 
button

Fig. 11-3: Right-Click Menu - Unit License
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Stage 2: Install License on the MV-8 Series Multiviewer
Fig. 11-4: Unit License Dialog - Selected License (An image for MV-821 is shown)

3 Select the available license to be installed. 
4 Click the Install License button.
5 An Install License dialog appears, click Yes to install the license.

The license is installed on the multiviewer and the multiviewer restarts (reboots).
Click OK.

6 Rebooting takes approximately 4 minutes.
While the unit is rebooting, RollCall Control Panel will lose connection with it.

When the multiviewer finishes rebooting, it is operating with the newly-installed license.

Selected 
License
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Software Upgrade Package

A software upgrade package from Grass Valley is supplied by Grass Valley Support and 
comprises a set of data and installer files, typically approximately 500M bytes in size. The 
package is associated with a MV-8 Series Multiviewer software version number, for example, 
3.1.4, and may contain a software upgrade for one or more devices.

Software Upgrade Procedure
The MV-8 Series Multiviewer (or for an MV-820-IP video IP block) software upgrading process 
follows the standard process for module upgrades with Grass Valley RollCall Control Panel. 
For more details, please see the Grass Valley RollCall Control Panel User Manual or 
the Grass Valley RollMechanic Operator’s Manual.

For RollCall Control panel, upgrade installation is a two-stage process:
• Stage 1: Add the upgrade package to RollCall Control Panel. 

    See Stage 1: Add Upgrade Package to RollCall on page 109.
• Stage 2: Install the upgrade on the MV-8 Series Multiviewer.

    See Stage 2: Install the Upgrade on the MV-8 Series Multiviewer on page 111.

These are described in the sub-sections below.

Stage 1: Add Upgrade Package to RollCall
This stage is applicable to upgrading an MV-8 Series Multiviewer (or to upgrading an MV-820-
IP/MV-821-IP product’s video IP block). 

The example below uses Grass Valley RollCall Control Panel. See Software Versions, on 
page 122, for the minimum version of RollCall Control Panel to use for the multiviewer device 
being licensed.

1 Run the RollCall Control Panel software.
2 Connect to the multiviewer block as required.
3 Click the Import New Upgrade icon, see Figure 11-5.

The RollCall Upgrade Packages window is displayed.

IMPORTANT 
Before carrying out an MV-8 Series Multiviewer software upgrade, please ask 
Grass Valley support for advice and inform Grass Valley support of the software 
versions you have for:

• MV-8 Series Multiviewer on your MV-8X0/8X1 Multiviewer product.
• Any other Grass Valley MV-8X0/8X1 Multiviewers.
• Orbit Client software application.
• GV Orbit Client software application.

Note: MV-8 Series Multiviewer software downgrades may also be carried out 
with the same procedure.
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Stage 1: Add Upgrade Package to RollCall
4 Click the Import Upgrade Package button.
5 Navigate into the folder containing the upgrade package.

Click on the .zip file name (see Figure 11-6).
Click OK.

6 A progress bar at the bottom of the RollCall Upgrade Packages window shows the 
upgrade package import progress. 
Import completion is reported in the Import Log pane. See Figure 11-7. 

Fig. 11-5: Import New Upgrade Icon

Fig. 11-6: Select Upgrade Package Window

Upgrade package folder name.zip file selected

Fig. 11-7: Example RollCall Upgrade Packages Window - Import Log and Currently Installed Panes 
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The upgrade package has been added to RollCall Control Panel. Any new licenses imported 
with the package are shown in the ‘Currently Installed’ panel of the RollCall Update Packages 
window.

7 Close the dialog.

Stage 2: Install the Upgrade on the MV-8 Series Multiviewer 
This stage is applicable to an MV-8 Series Multiviewer in an MV-8 Series Multiviewer unit 
(or to an MV-820-IP’s video IP block). 

The instructions below describe the upgrade procedure with RollCall Control Panel. When set 
going below, the upgrade sequence of events on the unit is:

• File(s) downloaded to the multiviewer unit.
• Software upgraded and the unit restarts itself. 
• Programmable logic (FPGA firmware) upgraded (if required by the upgrade package used).
• Upgrade complete.

Instructions
To upgrade:

1 Right-click on the connected unit name in the RollCall Control Panel window. See 
Figure 11-8.

2 Click Unit Upgrade in the drop-down menu. 
RollCall’s Unit Upgrade window is displayed.

Fig. 11-8: Right-Click Menu

unit name

Unit Upgrade
111



Stage 2: Install the Upgrade on the MV-8 Series Multiviewer
Fig. 11-9: Unit Upgrade Widow

3 Select the Upgrade All Files radio button.
4 In the Software Releases pull-down menu, select the Software Release required to 

upgrade to. 
5 Click Upgrade.
6 Click OK to upgrade.

A Unit Upgrade dialog is shown. 

Fig. 11-10: Unit Upgrade Dialog - Click NO

7 Click No in response to the question in the dialog (Figure 11-10). 

The upgrading begins...

Note: (Figure 11-10) “Do you wish to save the current version before 
upgrading?”
The MV-8 Series Multiviewer does not support saving of current 
software version. 
Click No in response to the message box shown in Figure 11-10.

Select ‘Upgrade All Files’.

Select the required software release to 
upgrade to.

Click ‘Upgrade’.
112



MV-8 Series Multiviewer
User Manual
8 The upgrade file is then automatically sent to the MV-8 Series Multiviewer. 
The MV-8 Series Multiviewer unit then starts to install the upgrade package onto itself. 

Note: Unit software and potentially the unit’s programmable logic circuitry is upgraded. 
This depends on the upgrade package. 

9 During the upgrade installation, the unit may restart one or more times and disconnect 
itself from RollCall Control Panel.

Fig. 11-11: Upgrade Log Messages - Upgrade In Progress

Fig. 11-12: Upgrade Log Messages - Upgrade In Progress

During the unit upgrade process, 
the multiviewer output screens may sometimes be blank or may briefly show some unit 
information similar to the start up splash screens. Information messages shown on such 
screens includes:

• Upgrading to vM.M.M  (for example, “Upgrading to V3.1.6”)
Please wait...

• MV-8XX Multiviewer Booting... (for example, “Upgrading to V3.1.6”)
Please wait...

• Programming FPGAs. From FPGA vMMM to vNNN. (for example, “v280 to v290”)
“Please wait 16 minutes...”

• Snnnnnnnn MV-8xx Multiviewer booting...  (see Booting and Splash Screen, on 
page 9, Figure 2-1)

10 While the software upgrade is finalizing (see Figure 11-13), 
if the MV-8 Series Multiviewer’s programmable logic (FPGA) requires upgrading as part of 
this upgrade package, then this FPGA upgrade is done. 
It approximately takes a further 16 minutes to complete an FPGA upgrade.
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Fig. 11-13: Upgrade Log Messages - In Progress (“Finalizing upgrade” message: Wait)

11 An ‘Upgrade Complete’ message finally appears in the Update Log pane of RollCall Control 
Panel when the upgrade is done. See Figure 11-14 for typical Update Log messages. 

Click OK.

IMPORTANT 
Wait for the MV-8X0/8X1 Multiviewer unit to fully finish installing the 
upgrade file:
The unit can take approximately 15 to 20 minutes to install its upgrade 
package, depending of whether any of the unit’s programmable logic also 
needs upgrading as part of the upgrade package.

IMPORTANT
Wait. The unit is only fully ready for use:

• after software upgrade; and 
• after any FPGA upgrade; and
• after it has restarted (i.e. after a reboot, see Booting and Splash Screen, 

on page 9) and is showing its head display outputs as a video wall 
layout.

IMPORTANT 
For MV-8 Series Multiviewer software versions earlier than 2.8.17:

Wait for the unit being upgraded to be ready for use.
And ignore “Upgrade Complete” messages in RollCall Control Panel’s 
Unit Upgrade window (the message does not indicate that the unit’s 
upgrade is complete).

For MV-8 Series Multiviewer software versions 2.8.17 onwards:

The “Upgrade Complete” message in RollCall Control Panel’s Unit 
Upgrade window does indicate that the unit has been upgraded.
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When the MV-8 Series Multiviewer has rebooted:

12 The unit’s multiviewer head display outputs re-show a video wall layout. 
13 Grass Valley RollCall Control Panel may be reconnected to the unit.

The control screen for the MV-8 Series Multiviewer shows the upgraded software version.
14 Check that the MV-8X0/8X1 Multiviewer product’s front module has a flashing green CPU 

Heartbeat LED. (Refer to the corresponding MV-8X0/8X1 Multiviewer user manual for LED 
information.) This means the multiviewer unit restarted and is running. 
If this is not the case, contact Grass Valley Support.

Fig. 11-14: Typical Upgrade Log Messages - Upgrade Complete

IMPORTANT: 
For early Multiviewer software 
versions before 2.8.17, ignore any 
“Upgrade Complete” messages in 
RollCall Control Panel’s Unit 
Upgrade window and await unit full 
start-up.

Upgrade Complete

Click OK
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Video Inputs 

Video Inputs

Inputs 48-off ‘up-to-12G’ SDI, dependent on product and license 
applied. Up to 32 embedded audio channels per input.

Note: ASI inputs are not supported by MV-8 Series Multiviewers. 
‘Loss of signal’ is reported for ASI inputs.

High Dynamic Range Inputs

HDR Optional HDR to SDR conversion. 

Opto-electrical Transfer Functions (OETFs) supported:
• PQ to SDR
• HLG to SDR
• Slog3 to SDR
• None (SDR-to-SDR)

Color Space Conversion to color spaces for inputs. 

Conversion:
• From BT.2020 color space to BT.709.
• None.

Media Biometrics Media biometric generator per input, analyzing input video and 
audio.
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Outputs
Outputs
 
Head Display Outputs

Head Display Outputs 4 to 12 enabled video outputs.
• Outputs 1 to 4 on enabled as standard on MV-8 Series 

Multiviewer.
• Outputs 5 to 12 enabled with MV-8 Series Multiviewer 

output licenses.

Embedded Audio 16 channels of embedded audio per output. Audio channel pairs 
selectable from multiviewer input embedded audio.

Reference Head Display Outputs locked to:
• External Reference; or
• Internal Reference (i.e. free running).

Video Standard Video Standard on head display outputs:
• 3G 1080p, or HD 720p 
• 50, 59.94 & 60 frames/s.

Delay Latency: 
• Interlaced inputs: 1 input field + 1 to 3 output frames.
• Progressive inputs: 1 input frame + 1 to 3 output frames.

H.264 Streaming Out of Video Inputs

Output Streams Up to 48-off H.264 streams, scaled copies of the multiviewer 
inputs. 

(On MV-821 multiviewers, this is a ‘H.264 stream’ licensed 
feature, also requiring factory-fitted hardware codec modules.)

Each multiviewer input is H.264 encoded to create streamed 
copies of the 48 inputs. 

Note: The H.264 streams do not function for the following 
slower-frame-rate HD standards:

• 1080p30 (and slower frame rates); and
• 720p30 (and slower frame rates).

Ethernet Port Streamed out over multiviewer’s control and monitoring 
Ethernet port. Refer to respective MV-8X0/8X1 Multiviewer 
product user manual for Ethernet interface details.

(These H.264 streams can be viewed on desktop PCs using GV 
Orbit Client, or via the Orbit client with the Orbit MV-800-DT 
license option if using the Orbit client). 

User applications include: confidence monitoring, compliance 
monitoring.)
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Multiviewer Monitoring and Alarms 

Monitoring and Alarms

Video:

Input: Monitoring of multiviewer video input:
• Media Biometrics.
• XDS.

Support for HDR inputs.

On-Screen 
Monitoring:

Fully flexible layouts:
• Any object can be any size, in any position.
• Adjustable layering and transparency of objects 

over video or other objects or background.
• Display up to 48 video tiles on a single screen. 
• Any router input can be assigned to any screen.
• WSS/AFD flags. 

Alarms:
• Video Input signal loss
• Video black
• Picture freeze or still
• Video Input format change.

Audio:

On-Screen 
Monitoring: • Metering of AES embedded audio:

• VU, extended VU, DIN, BBC, and Nordic scales
• Up to 32 audio channels per video signal
• Bars outside or overlaid on picture
• Audio meter scales on/off
• Programmable color & alarm thresholds

Alarms:
• Loss of:

• AC3 encoded audio data, 
• Dolby E encoded audio data.

• DialNorm under preset threshold. 
• Dolby E configuration change.
• Audio Level:

• Loss of audio.
• Audio level low/high.

Metadata and Control Monitoring:

On-Screen 
Monitoring: • Closed Caption & Subtitle detection

• V chip detection
• Display UMD router source names 

via General Remote protocol SW-P-08 over IP
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Video Wall Screen Display
Video Wall Screen Display

Alarms: Loss of:
• Teletext. 
• Closed Caption (CC). 
• TS ID. 
• V-chip. 
• VITC. 
• Extended Data Services (XDS).

Alarm Control: Controls and features for:
• Configurable alarms trigger delays
• Alarm acknowledge/clear/previous fault indication (border 

color or tally alarm box)
• Alarm acknowledge from hardware or soft panels via 

Rollcall interface
• Layout recalls from hardware or soft panels, on-screen 

message boxes via Rollcall
• Alarm auto-clear after configurable period of time.

Monitoring and Alarms

Screen Display

Screen Design Facilities:
• Drag and drop objects on screen
• Configurable grid
• Snap to grid
• Object grouping and re-sizing
• Fixed/adjustable video tile aspect ratios
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Closed Captions Support for displaying closed caption information.

In an Orbit multiviewer video wall design, use an Orbit ‘Closed 
Caption’ Behaviour to access closed caption information from 
MV-8 multiviewer video inputs. ‘Closed captions’ are supported 
for EIA-608 “line 21” and for EIA-708 in compatibility-byte mode. 
Page numbers to use:

• CC1 - page 101
• CC2 - page 102
• CC3 - page 103
• CC4 - page 104
• WST - page 888 
• OP42 - page 801 (typically)
• OP47 - page 801 (typically)

Note: For SD video input sources, the vertical blanking interval 
(VBI) is used: 

For 625/25: 
• VITC is detected on line 19;
• OP42/WST on line 21; and
• WSS on line 23.

For 525/29: 
• VITC is detected on line 14; and
• Rec. 608 on line 21.

For HD/3G video input sources, the ancillary data (ANC) is 
used and there is no line number restriction.

Time code Time code:
• Display time code extracted from video and from 

multiviewer time code input

Time Time:
• Multiple clock display – lock to NTP, VITC or LTC, with time 

zone offsets
• Generate real-time clocks and timers with count up/down 

capability

Miscellaneous Control direct from mouse on screen.

TSL tally display.

Graphics / Images:
• Add graphics files to display labels and channel logos, etc
• Programmable background color or image

Screen Display
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Software Versions
Software Versions 

Tool Version

RollCall Control Panel 4.20.5 or later

Orbit Client 3.1.15 or later

GV Orbit 1.0.0 or later

GV Orbit Client 4.0.0 or later

MV-8 Series Multiviewer 3.2.22 or later

Note: For future releases:

Please refer to software release notes for compatibility 
information.
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XDS Data Types Supported
Program Identification Number (Scheduled Start Time) ........................................ page 123
Length / Time-in-Show ....................................................................................................  page 123
Program Name (Title) (V Chip Label) ...........................................................................  page 124
Program Type .................................................................................................................... page 124
Content Advisory (V Chip Rating) .................................................................................  page 124
Program Description ....................................................................................................... page 124
Network Name (Affiliation) ............................................................................................ page 124
Call Letters (Station ID) and Native Channel .............................................................  page 124
Time of Day ........................................................................................................................  page 125
Local Time Zone ................................................................................................................  page 125

 Table B-1:   XDS Data Types Supported  

XDS Type
XDS Class Data Description

RollCall 
Command 

Number

(Hexa
decimal)

Program Identification Number (Scheduled Start Time)
Current 01 MM/DD hh:mm

Where:

MM = Month (1 - 12)

DD = Date (1 - 31)

hh = Hours (0 - 23)

mm = Minutes (0 - 59)

1800 - 1847

Length / Time-in-Show
Current 02 This carries two items of relevant data:

Program length: hh:mm

Where:

hh = Hours (0 - 63)

mm = Minutes (0 - 59)

1850 - 1897
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Program Name (Title) (V Chip Label)
Elapsed time: hh:mm:ss

Where:

hh = Hours (0 - 63)

mm = Minutes (0 - 59)

ss = Seconds (0 - 59)

1900 - 1947

Program Name (Title) (V Chip Label)
Current 03 A character string, up to 32 characters in length. 1600 - 1647

Program Type
Current 04 A list of up to 32 character strings.

Each string represents a descriptive name for 
the program content. 
For example, 
 “Education”, “Comedy”, ”Travel” etc.

For a list of names see the CEA-608-B 
specification.

2000 - 2047

Content Advisory (V Chip Rating)
Current 05 A short indication of the program rating. The 

string produced for each category depends on 
the region/rating system used. 

For full information, see the CEA-608-B 
specification.

1650 - 1697

Program Description
Current 10 - 17 A list of 8 strings separated by new lines. 1750 - 1797

Network Name (Affiliation)
Channel 
Information

01 A string of up to 32 characters. 1950 - 1997

Call Letters (Station ID) and Native Channel
Channel 
Information

02 This carries two items of relevant data:

Station ID.

Consists of a 4 character string.

2100 - 2147

Native channel.

Consists of a 2 character string.

2150 - 2197

 Table B-1:   XDS Data Types Supported  (continued)

XDS Type
XDS Class Data Description

RollCall 
Command 

Number

(Hexa
decimal)
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Time of Day
Miscellaneo
us

01 WWW DD/MM/YYYY hh:mm

Where:

WWW = Day of the week 
    (Sunday to Saturday)

DD = Date (1 - 31)

MM = Month (1 - 12)

YYYY = Year (1990 - 2053)

hh = Hours (0 - 23)

mm = Minutes (0 - 59)

2050 - 2097

Local Time Zone
Miscellaneo
us

04 Two-character string: hh

Where:

hh = Hours (0 - 23)

2200 - 2247

 Table B-1:   XDS Data Types Supported  (continued)

XDS Type
XDS Class Data Description

RollCall 
Command 

Number

(Hexa
decimal)
125



Local Time Zone
126



SNMP Support
SNMP Support
Introduction .......................................................................................................................  page 127
MIB Files .............................................................................................................................. page 128
MV-8 Series Multiviewer MIB .......................................................................................... page 128

mvStatus .................................................................................................................. page 129
mvAlarms ................................................................................................................ page 130
mvControl ................................................................................................................ page 131
mvEvents ................................................................................................................. page 132

Introduction
The MV-8 Series Multiviewer supports Simple Network Management Protocol (SNMP). The MV-
8 Series Multiviewer Management Information.

The MV-8 Series Multiviewer System-Setup control screen has some SNMP settings. (See 
System-Setup Control Screen, on page 15, SNMP Managers box, on page 22, and SNMP 
Community Strings box, on page 22.)

Up to 8 SNMP managers can be configured to receive trap messages from the MV-8 Series 
Multiviewer. Once configured, a trap message will be sent to each manager whenever there is 
a change of alarm state.
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MIB Files
MIB Files
Management Information Base (MIB) files provide a graphical representation of the SNMP 
device to the user via a MIB browser tool. The following MIB files are required by an SNMP 
browser:

• PROBEL-COMMON.mib
• Multiviewer.mib

MV-8 Series Multiviewer MIB
The MV-8 Series Multiviewer MIB is ‘Multiviewer.mib’ , which has four main sections, see 
Figure C-1.

Fig. C-1: MV-8 Series Multiviewer MIB Tree

Note: Contact Grass Valley Customer Support for the MIB files. 
https://www.grassvalley.com/contact/support/

The multiviewer MIB tree comprises:

• mvStatus, on page 129
• mvAlarms, on page 130
• mvControl, on page 131
• mvEvents, on page 132
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mvStatus
The mvStatus section displays the overall status of the MV-8 Series Multiviewer, providing the 
similar information to that accessible in Orbit by right-clicking on the multiviewer name in the 
Network View and selecting ‘Details’ . See Figure C-2.

Fig. C-2: mvStatus MIB Tree

a) mvStatus MIB section b) In Orbit, right-click on multiviewer in Network View, select ‘Details’ .
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mvAlarms
mvAlarms
The mvAlarms section comprises two sub-sections: unitAlarms and inputAlarms. It displays 
the alarm states of the MV-8 Series Multiviewer. See Figure C-3.

Fig. C-3: mvAlarms MIB Tree

unitAlarms:

• Temperature alarms (tempAlarmTable) - Providing names, status 
and temperature for each of the temperatures monitored.

• PSU alarms (psuAlarmTable) - Providing names and status for each 
of the PSUs monitored.

• Fan alarms (fanAlarmTable) - Providing names and status for each of 
the fans monitored.

• Reference and genlock state

inputAlarms:

This consists of a table of alarms for each of the 48multiviewer inputs. 
These can also be set up/viewed in Orbit or via the RollCall protocol.

•
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mvControl
The mvControl section contains a ‘wallLayoutTable’, which allows control and interrogation of 
the video wall layout currently selected for each video wall. It allows the currently-selected 
layout to be changed on each of the walls. See Figure C-4.

Fig. C-4: mvControl MIB Tree
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mvEvents
The mvEvents section lists the available SNMP traps that may be sent. See Figure C-5.

Fig. C-5: mvEvents MIB Tree
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Appendix contains:
MV-800-DT Option
Overview of MV-800-DT Orbit Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .134
Orbit Software Installation for Multiviewer Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .137
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .138
Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .139

License Server Preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
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PC Video Wall  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Configure Multiviewer for MV-800-DT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .141
LAN System Set Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

Configure Orbit Project for MV-800-DT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .143
Orbit Project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Orbit License Option Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Orbit Video Option Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
Orbit Launch Option Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Video Wall and Video Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .148
Auto-Tile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Create a User Variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Custom Tile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

Launching Orbit Video Wall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .152
Running Orbit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Orbit Window Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
Switching into Design Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

This section describes the MV-800-DT license option used with the older Orbit Client software 
tool to view MV-8 Series multiviewer H.264 video streams.

Note: The older ‘Orbit’ Client software does not have native support for 
viewing MV-8 Series H.264 video streams.
However, the newer ‘GV Orbit’ Client does have native support and 
no license option is required.
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Overview of MV-800-DT Orbit Option 

The MV-800-DT desktop multiviewer provides live video wall capabilities to a PC, extending the 
capabilities of an MV-8X0/8X1 Multiviewer. It can be used with the Orbit Client software. The 
MV-800-DT is a licensed feature of Orbit and is issued by a license server software application, 
typically running on a separate PC.

An MV-8X0/8X1 Multiviewer can produce H.264, scaled streamed versions of each of its 48 
multiviewer inputs. The input video is scaled to SD video size, H.264-compressed, streamed 
and multicast from a designated MV-8X0 network port.

These H.264 streams can be viewed on an Orbit MV-800-DT video wall on a PC. These can be 
displayed with the same or with a different video wall layout as the MV-8X0/MV-8X1 unit. 
Streams from one or more MV-8X0/MV-8X1 units can be viewed. Live information on an 
MV-800-DT video wall includes video, audio levels and alarms. 

One or more MV-8X0/8X1 Multiviewer can provide H.264 streams to one or more MV-800-DT 
video wall. “One-to-Many” and “Many-to-One” video wall topologies are possible, see 
Figure D-7, and Figure D-8 shows other flexible MV-800-DT possibilities.

Note: This section applies if using the older ‘Orbit’ Client application to 
view MV-8 Series H.264 video streams.
If using the newer ‘GV Orbit’ Client application, then this section 
does not apply.

Note: For some multiviewer units, H.264 streaming needs a multiviewer 
‘H.264 stream’ license. 

Note: MV-821 multiviewer units require factory-fitted codec hardware 
modules.

Fig. D-6:  MV-800-DT Multiviewer PC-based Video Wall

MV-8X0/MV-8X1 Unit:

For example,
Sirius 800 Router with 

MV-800 fitted

MV-800-DT Video Wall

PC-based video wall

H.264 IP Streaming
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Fig. D-7:  MV-800-DT Multiviewer Video Wall Topologies, a) “One-to-Many”; b) “Many-to-One”

Sirius 800 Router 
with MV-800 fitted 

(example)

MV-800-DT Video Wall

H.264 IP Streaming

MV-800-DT Video Wall

MV-800-DT Video Wall

MV-8X0/MV-8X1 Video Walls

a) “One-to-Many”

b) “Many-to-One”

H.264 IP Streaming

H.264 IP Streaming

MV-8X0/MV-8X1 Video Walls

MV-8X0/MV-8X1 Video 
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Fig. D-8:  MV-800-DT Multiviewer Video Wall Topology Possibilities

H.264 IP Streaming

MV-8X0/MV-8X1 Video Walls

MV-800-DT Video Wall

MV-800-DT Video Wall

H.264 IP Streaming

H.264 IP Streaming

H.264 IP Streams 
from other sources
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Orbit Software Installation for Multiviewer Applications
One Orbit Client software application is for multiviewer video wall configuration. The Orbit 
software is installed on a PC in order to:

• Configure Orbit-enabled Grass Valley products. 
 For example, configuring video wall layouts for an MV-8X0/8X1 Multiviewer.

• Display H.264 IP streams on a PC-based video wall with an MV-800-DT license.
 For example, displaying H.264 IP streams from an MV-8X0/8X1 Multiviewer.

For full information about installing and using Orbit for multiviewer applications, 
please see the published Orbit manuals:

• ‘Orbit Introduction’ user manual; and 

• ‘Orbit for Multiviewers’ user manual.
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System Requirements 
Assuming that an MV-8X0/8X1 Multiviewer unit is already configured and up-and-running, the 
MV-800-DT system typically uses three PC’s performing different roles, although just one PC 
could be used for all roles:

1 A Wall Design PC - used to design video walls with Orbit software.
2 A Video Wall PC - used for the PC-based video wall with Orbit software using the 

MV-800-DT license.
3 A License Host PC - used to act as a license server.

Video Wall PC:

The system requirements for the Video Wall PC are given in Table D-1:.

Fig. D-9:  MV-800-DT Multiviewer Video Wall

 Table D-1:   Minimum System Requirements for a MV-800-DT system PC

System Component Requirement

CPU Intel i7

RAM 32GB

Graphics Card Nvidia K620 GPU

Network Interface 1G Ethernet

OS 64 bit, Windows 7

1)
2)

3)

Video walls direct from MV-8X0/MV-8X1

MV-800-DT PC-based video wall from MV-8X0
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Installation
These instructions will get the MV-800-DT option up-and-running. There are several stages to 
getting a MV-800-DT option working and these stages are listed below and are described in 
the indicated sub-sections.

License Server Preparation
Prepare the license server on the License Host PC:

1. License Server Install license server tools on a host PC.

See License Installation for Orbit, Install License Server on 
page 155.

2. Lock Code Get a Lock Code for the license host PC.

See License Installation for Orbit, Lock Code for License Host PC 
on page 158.

3. Procure Option Procure an MV-800-DT option from Grass Valley via a purchase 
order. 

Note: The option license supplied by Grass Valley is a small text file, 
which may contain one or more MV-800-DT licenses. Store 
file in a safe place.

4. Install License Add the MV-800-DT option license file to the license server 
running on the license host PC.

See License Installation for Orbit, Add Orbit License to License 
Server on page 160.

The license server is now prepared. 
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Configuration Stages

PC Video Wall


Configure the MV-8 Series Multiviewer:

5. Configure 
MV-8X0 

Configure a MV-8X0/8X1 Multiviewer unit with Grass Valley 
RollCall Control Panel.

 See Configure Multiviewer for MV-800-DT on page 141.

Note: An MV-8X0/8X1 Multiviewer is configured to use the same 
Ethernet port for streaming out H.264-encoded multiviewer 
inputs and for general RollCall control and status messages.

Now set up the Video Wall PC:

6. (H.264 Stream video player - for early Orbit versions only)

Only install a H.264 streaming video player if using Orbit versions 
earlier than 
Orbit v2.5.16. (Later Orbit versions include such a video player.)

To install the VLC streaming video player on the Video Wall PC:

 See VLC Video Stream Player Installation on page 163.

7. Orbit Install Orbit Client software on the Video Wall PC.

 See Orbit Software Installation for Multiviewer Applications on 
page 137.

8. Multiviewer 
Project 

Modify an Orbit multiviewer video wall project for running on the 
Video Wall PC.

 See Configure Orbit Project for MV-800-DT on page 143.

And:

 See  Video Wall and Video Sources on page 148.

This completes the installation and preparation. 

To see the PC-based video wall:

9. Desktop Video 
Wall 

Run the Orbit Client on the Video Wall PC.

 See Launching Orbit Video Wall on page 152.
140



MV-8 Series Multiviewer
User Manual
Configure Multiviewer for MV-800-DT
This sub-section describes the configuration of a multiviewer product for the MV-800-DT 
option.

Run the Grass Valley RollCall Control Panel application on a PC:
1 Connect to a MV-8 Series Multiviewer to view control screens. 

Go to the System-Setup screen and locate the Streamed Output box. See Figure D-10.

Note: Refer to Getting Started on page 73, for information about 
connecting to a unit and its initial configuring.

Note: Configuration in this sub-section is done via the multiviewer 
product’s RollCall templates (control screens). 

This sub-section uses the Grass Valley RollCall Control Panel 
tool to view and edit these control screens.
However, Orbit Client 3.0 onwards may also be used to view 
and edit control screens.

Fig. D-10:  System-Setup - Streamed Output box
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LAN System Set Up
In the Streamed Output box:
2 Set Ethernet Interface to be the same as ‘Ethernet Interface’ in the RollCall Settings box, 

above in the same window.
3 Enable H.264 streaming output by selecting the Enable check box.
4 Leave the IP Port setting alone. 

(It is a predefined port number and is used for the RTSP control protocol used for the 
streaming out of the H.264-encoded multiviewer inputs.)

5 Leave the Multicast Group Base Address box blank. 
The H.264 streamed outputs will then use a set of IP multicast addresses using a suitable 
randomly-chosen base address from the 232/8 address block. (See Multicast Group 
Addresses on page 21 for details.)

The MV-8 Series Multiviewer network interface port setting is now set up for H.264 multicast IP 
streaming out of multiviewer inputs (i.e. H.264-encoded). 

All changes in the System-Setup screen should have now been made. 

A system reset is required for the multiviewer: 
6 Click on the System Reset button at the top of the System-Setup screen.

Then click on the Confirm button to perform a system reset. 
The MV-8 Series Multiviewer unit is restarted and the new settings will be adopted.

LAN System Set Up
In the LAN system network configuration:

1 Ensure that the following are enabled on the LAN between the multiviewer device and 
MV-800-DT video wall PC.

• The RTSP port on the multiviewer’s IP address.
• The multicast address range.



Note: If a particular multicast address range is required for the H.264 
streamed outputs, then enter a Multicast Group Base Address 
in the box and click “S” to save this new setting. This may be the 
case if more than one multiviewer device is on the network.

Note: Multicast IP Port Numbers:

Each multiviewer input is H.264-encoded and streamed out on 
its own multicast IP address with the RTP protocol, video data 
and control data (e.g. quality, statistics) use different IP port 
numbers on the respective IP address.

IP port numbers used on the respective multicast IP addresses 
for multiviewer inputs are: 

• Input 1: video data=18888; RTP control data = 18889.
• Input 2: video data=18890; RTP = 18891.
• Input 3: video data=18892; RTP = 18893.
• ...
• Input 48: video data=18982; RTP = 18983.
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Configure Orbit Project for MV-800-DT
In this section, an Orbit multiviewer project is modified to use an MV-800-DT option. This 
project will be run with Orbit on the Video Wall PC. Carry out these steps on the Video Wall PC.

A project can be modified from an existing MV-8 Series Multiviewer Orbit project, or it can be a 
new and separate project. Modifying an existing project enables video walls from an existing 
MV-8 Series Multiviewer to be shown on the Video Wall PC

Using a new and separate project (or a heavily modified existing project) means that selected 
video inputs can be shown on the Video Wall PC. By selecting fewer displayed video inputs, 
larger video tiles are possible on the Video Wall PC. Additionally, a separate project can show 
H.264 streams from more than one MV-8 Series Multiviewer source, or from some other source.

Orbit Project
1 Pull a multiviewer project from an MV-8 Series Multiviewer 

or create a new Orbit project.

Modifications to a Orbit project:

2 Open the project in Orbit.
3 Click Multiviewer > Properties.

The Multiviewer Properties window is displayed, see Figure D-11.

4 Set the Streaming Configuration box Multiviewer IP and Multiviewer Port to be the 
same as the RollCall Settings in the System-Setup screen of RollCall Control Panel for the 
MV-8 Series Multiviewer that will be sourcing the H.264 IP streams.
Click OK.

Fig. D-11:  Multiviewer Properties window - Streaming Configuration box

Note: The Multiviewer IP and Multiviewer Port values are used by Orbit to 
form the video source URL’s for video wall ‘auto-tiles’. 

If a different URL is required on an auto tile, it may be converted to 
a custom tile. 
And the video H.264 streaming URL of a Custom Tile may be 
specified.
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Orbit License Option Settings
1 Click Tools > Options.

The Options window is displayed.
2 Select the Licen... tab. (Tools > Options > Licen...)

The License tab is displayed, see Figure D-12.

3 Select Enable licensed features.
4 Enter the name of the license host PC in the License server host text box.
5 Do not change the License server port setting.
6 Click Close.
7 Click File > Save Project.

Click File > Exit to close Orbit.

Restart Orbit with these new License server settings.
8 Restart Orbit.

Re-open the same project to continue modifying the Orbit project for MV-800-DT.

Fig. D-12:  Tools > Options, License tab
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Orbit Video Option Settings
1 Click Tools > Options.

The Options window is displayed. 
2 Select the Video tab. (Tools > Options > Video)

The Video tab is displayed, see Figure D-13.

3 Set Network caching (ms) to a value between 32 and 1000. 

4 Select Enable hardware accelerated video decoding. 
This enables Orbit to use the Video Wall PC’s graphics card (GPU) to accelerate video 
rendering. 

5 Set Quality to ‘Maximum’. 
Other settings (‘High’, ‘Low’) will act to reduce the PC loading on the Video Wall PC
- the quality of the rendered video on the Video Wall will be reduced. 

Fig. D-13:  Video tab

Note: Network caching is the time delay until video rendering begins (i.e. 
the amount of network data to buffer up). 

The value depends on the number of video tiles being rendered 
on the PC-based video wall and the IT network used by the video 
H.264 streaming.

Increase this value if the network cannot sustain data delivery to 
the Orbit Client.

Note: Use of hardware acceleration is recommended.

Note: The Quality setting offers a rendered video quality trade-off to the 
user. PC loading can be reduced at the expense of reduced video 
quality on the PC-based video wall.
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Orbit Launch Option Settings
1 Select the Launch tab. (Tools > Options > Launch)

The Launch tab is displayed, see Figure D-14.

2 Select Load project when starting Orbit.

3 Set the Project text box to path to the required project. (Click Set Current to set it to the 
current project.)

4 Fill out the user name and password to use to login at launch for this project.
5 In the Target drop-down box, select the target screen on which to view the video wall.

Fig. D-14:  Launch tab

Note: With Load project when starting Orbit check box de-selected, the 
Orbit application starts normally with no project open.

Note: Target drop-down box options for where to view the live video wall at 
launch are:

• Application window - The Orbit application window.

• Screen 1 - PC monitor screen 1 *.

• Screen 2 - PC monitor screen 2 *.

* Upon selecting either Screen 1 or Screen 2, 
a helpful screen-identifying flash-message is overlaid on the 
corresponding screen for a second, ‘Screen 1’ or ‘Screen 2’. 
See Figure D-15.

Launch Project 
information

Launch Options
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6 In the Target radio buttons,
click Launch a specific file.
In the drop-down box, select the required (project) file to be displayed at launch. This will 
typically be a video wall, i.e. a ‘.wall’ file from the Project Pane.

7 Click Close.
8 Click File > Save Project.

To set up an Orbit video wall to display video H.264 streams, see Video Wall and Video Sources 
on page 148.

Fig. D-15:  Target Screen Identifying Flash-Message

Note: Target radio buttons are:

• Disabled - No launch.

• Launch the current home - A defined page is shown at launch 
(defined by clicking Project > Set Home.)

• Launch a specific file - a file is specified, usually this is a Orbit 
project’s ‘.wall’ file, the video wall required.
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Video Wall and Video Sources
In this section, a Orbit multiviewer project’s video wall is modified for showing streamed 
multiviewer inputs on a Video Wall PC. 

A URL of each video H.264 stream must be defined for each video tile showing (H.264) 
streaming video. The mechanism for doing this depends on whether the tile is a video auto-tile 
or custom tile; this is covered below:

Auto-Tile
1 Open the project with Orbit.
2 Open the required video wall and single-click on a video auto-tile.

The video tile is selected and its properties are shown in the Properties box, on the 
right-hand side, see Figure D-16. 

3 Select the Tile > Preferences > Streaming Video property.

The Tile > Streaming > Source Path property is then shown in the Properties box, see 
Figure D-16. 

Note: The displayed source path is automatically generated by Orbit from information in 
the Multiviewer > Properties window, see Figure D-17.

Fig. D-16:  Selected Video Auto-Tile Properties

Tile > Streaming > Source Path property

Properties BoxSelected Video Auto-Tile
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The Source Path property is a URL formed automatically by Orbit for a video Auto-Tile.

If the URL needs to be customized:
• A user variable may be set up for the IP address of the sourcing multiviewer device.
• A video Custom Tile needs forming from a video Auto-Tile and its tile properties edited.

Create a User Variable
The tile’s Source Path property value may be set to use a user variable in Orbit:

1 Select Project > Edit Variables in the main menu.

The Properties dialog is shown.
2 Create a new variable, for example ‘MV IP’ , and set its value to be the IP address of the 

multiviewer sourcing the H.264 IP streams. See Figure D-18.

Fig. D-17:  Multiviewer > Properties, Streaming Configuration

Note: Source path example, 
Tile > Streaming > Source Path property:

rtsp://10.162.51.31:5986/Stream48

Where:

• rtsp: - Real time streaming protocol prefix. Protocol is used for 
establishing and controlling media sessions between two 
network ports.

• 10.162.51.31 - IP address of unit sending the video stream, 
Multiviewer IP.

• 5986 - IP port number of the unit sending the video stream, 
Multiviewer Port.

• Stream48 - Video H.264 stream name, formed from the 
Multiviewer input feeding the video tile, Input 48.
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Custom Tile
Fig. D-18: Properties Dialog with New Variable Defined

3 Click OK.

The variable name may be used throughout the Orbit project, including in Source Path 
property values.

Custom Tile
1 Open the project with Orbit.
2 Open the required video wall and double-click on a video custom tile or on a video 

auto-tile.
The tile is opened in the Tile Editor, see Figure D-19.

Fig. D-19:  Tile Editor - Video Widget Properties

IMPORTANT
Any Auto-Tile edited in the Tile Editor becomes a Custom Tile.

Video Widget selected
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3 Click on the video widget to select it.
The video widget properties are shown on the right-hand side. See Figure D-19.

4 The Video > Source Path property shows the URL of the video H.264 stream.
This text box is editable.

Fig. D-20: Video > Source Path Property URL Value

5 Click File > Save to save changes.

Other tile properties:

6 Select the Video > Muted property.

7 If the source video is progressive, then set the Video > Deinterlace property to ‘off’.
8 Click File > Save to save changes.
9 Click File > Save Project.

Click File > Exit to close Orbit.

The project will be used by Orbit on the Video Wall PC to show a live video wall on the PC 
monitor screen. 

To launch Orbit, see Launching Orbit Video Wall on page 152.

Note: A variable is used by enclosing the variable name in curly braces, 
{VarName}. The variable’s value is substituted by Orbit when the 
project runs. 

• {MV IP} - The user variable value is substituted by Orbit - in 
this case, the sourcing multiviewer’s IP address.

• {Input} - A video input number is assigned by Orbit when 
the custom tile is placed into a wall and the project run. 
More than one such tile may be placed. Orbit then assigns 
video input numbers to all instances of the ‘Input’ system 
variable.

Note: The system variable ‘Input’ is enumerated and expanded by Orbit. 
Any tile or widget properties containing the ‘{Input}’ construct will be 
auto-numbered from 1 to 48.

Thus, “Stream{Input}” will be expanded to be: 
“Stream1”, “Stream2”, ... “Stream48”.

Note: Audio is muted in the video H.264 streams.

‘MV IP’ user variable (set to IP address of a sourcing multiviewer device)

RTSP IP port number

‘Input’ is an Orbit system variable, managed by Orbit and set to 
an integer 1 to 48, multiviewer video input number.
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Launching Orbit Video Wall
All steps in the installation and preparation should now be done (described in Installation on 
page 139) and Orbit is now configured to open a project and display a live video wall at launch 
(start-up). (Orbit launch options are described in Orbit Launch Option Settings on page 146.)

Running Orbit

Run Orbit on the Video Wall PC. 

The Orbit application then:

• Starts up. 

• Opens the preset Orbit project and logs in.

• Gets an MV-800-DT license from the license server. 

• Displays a video wall on the PC monitor screen. 

Figure D-21 shows a full-screen video wall seen on one of the Video Wall PC’s monitors.

Note: The normal ‘user name’ and ‘password’ login steps when opening a 
Orbit project are not presented at Orbit launch. These have already 
been set up within Orbit.

Note: The Video Wall PC running Orbit requires to access the MV-800-DT 
license from the License Host PC. The Video Wall PC and the License 
Host PC must be able to see each other on the network. 

If communication with the license host PC fails, a license check 
message appears.

Fig. D-21:  Full-screen Live Video Wall (Layout 1)
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Figure D-22 shows a live video wall (in this case a second wall layout, Layout 2) being shown in 
a tab screen within the Orbit application window. Figure D-23 shows the same video wall 
undocked.

Fig. D-22:  Full-screen Live Video Wall - Layout 2, docked in the Orbit Application window

Fig. D-23:  Full-screen Live Video Wall - Layout 2, in an undocked window
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Orbit Window Controls

Right-clicking in the live video wall area produces a context menu, see Fig. D-24:.

Switching into Design Mode

Orbit has been configured to launch in ‘Run-Mode’ for displaying live video walls with the 
MV-800-DT license. 

Click the Run-Mode/Design-Mode icon in the Orbit main tool bar, see Fig. D-25:, to change 
into ‘Design Mode’. Wall editing may be done in ‘Design Mode’. 

Clicking the icon toggles between the two modes of Orbit operation.

Fig. D-24:  Right-Click in Live Video Wall - Context Menu

 Table D-2:   Right-Click Live Video Wall - Context Menu Items

Alarm Description

Dock Window Restores a video wall window to a tab screen in the Orbit 
window.

Full Screen Toggles between viewing a wall full-screen and in docked or 
undocked window (a separate window or as a Orbit tab 
screen).

Alt+Enter
Pressing the ‘Alt’ key with the ‘Enter’ key does the same 

Scale to Fit Scale a video wall image to fit the Orbit window. 
Not used when full-screen.

Switch Layout Change between wall layouts.

Fig. D-25:  Run-Mode/Design-Mode icon

b) Design Mode

a) Run Mode
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Appendix contains:
License Installation for Orbit
Install License Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .155
Lock Code for License Host PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .158
Add Orbit License to License Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .160

This section describes installation of some software applications etc. required for an Orbit 
license. For example, to get the MV-800-DT option working for the Orbit Client software tool. 
The installation and preparation steps covered are:

• License server installation.

• Lock Code generation.

• Adding the license. 

Install License Server 
The license server application should be installed on a license server host PC. The PC must be 
on the same network as the PC generating the PC-based video wall and any MV-8X0/8X1 
Multiviewer units producing live video input streams and data.

The license server application used is the same as that used for some other Grass Valley 
products, for example Alchemist XF. If such a license server already exists on the network, then 
no further action is needed to install one. Otherwise, a license server application must be 
installed by following the steps below.

To get the licensing tool installer files onto the license host PC, either:

• Copy across part of a Orbit installation folder from another PC onto the license host PC, 
C:\Program Files\...\Orbit\LicensingTools.

 or, alternatively,

• Install Orbit on the license host PC, 
see “Add Orbit License to License Server” on page 160.
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Install License Server
Then:

1. On the license host PC, go to the 
C:\Program Files\...\Orbit\LicensingTools\Setup sub-folder. 

2. Run setup.exe.
The licensing tools installation begins and an initial screen is shown.

3. Click Next at the initial screen.

4. Read and accept the License Agreement.
Click Next.

5. At the Customer Information screen, enter the information.
Click Next.

6. At the Destination Folder screen, select the default installation folder.
Click Next.

7. At the Setup type screen, select the Complete setup type.
Click Next.

Fig. E-26:  Licensing Tools ‘setup.exe’

Fig. E-27:  Licensing Tools Setup Initial Screen
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8. At the System Firewall Settings screen, select the text box for “Unblock the system 
firewall for the Sentinel RMS License Manager”.
Click Next.
The ‘Ready to Install the Program’ screen appears, see Figure E-28.

9. Click Install.
Installation begins and a progress bar is shown.
The install complete screen is shown when installation is done.

10. Click Finish.
Licensing Tools installation is now finished.

11. Restart the license host PC.

The licensing tools are installed on the license host PC. The licensing tools are run as a service 
when the license host PC is restarted.

Fig. E-28:  Licensing Tools - Ready screen

Fig. E-29:  Licensing Tools - Complete screen
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Lock Code for License Host PC
A Lock Code is required to be generated from your license host PC. This is a kind of fingerprint 
of your machine, which ensures your license will be served by the license server.

The Lock Code must be supplied to Grass Valley when ordering an Orbit license, for example for 
the MV-800-DT option.

The Lock Code generation is described in this sub-section. 

The Lock Code generating utility is found in a Orbit installation folder. To get the utility onto the 
license server PC, either:

• Install Orbit on the license host PC.

 or

• Copy across the Orbit installation folder from another PC.
C:\Program Files\Grass Valley\Orbit...

Then:

1. On the license server PC, 
go to C:\Program Files\...\Orbit\LicensingTools.

2. Run the file ‘wechoid.exe’. 
A Lock Code generation window appears entitled ‘Wechoid’. See Figure E-30.

Note: The Lock Code is case-sensitive and must be supplied to Grass Valley 
exactly as it appears after these Lock Code generation steps.

Fig. E-30:  Lock Code ‘Wechoid’ window

Lock 
Code 
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3. Select and deselect the various left-hand side Locking Criteria check boxes so that 
they are the same as in Figure E-30.

4. Check that the value in the Selector text box is the same as that in Figure E-30. 

5. The value in the Code text box is the Lock Code for your host PC.
Record the Lock Code for sending to Grass Valley. 

6. Keep the record of your Lock Code safe.
Close the Wechoid window.

Supply the Lock Code to Grass Valley with your Orbit option purchase order.

Note: The Lock Code is case-sensitive and must be supplied to Grass Valley 
exactly as it appears in your Wechoid window on the license host PC.

Take a screen shot of your Wechoid window with the Windows 
snipping tool or similar.
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Add Orbit License to License Server
This section deals with adding the license file to the license server. 

On the license host PC:

1. Go to 
C:\Program Files\Grass Valley\Orbit\LicensingTools.

2. Run ‘WlmAdmin.exe’, the license administration tools.
The WlmAdmin window appears, see Figure E-32.  

3. Expand the ‘Subnet Servers’ tree view item and locate the license host PC.

Fig. E-31:  Run ‘WlmAdmin.exe’

Fig. E-32:  WlmAdmin Window
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4. Right-click on the license host PC item 
and click on Add Feature > From a File > To Server and its File, see Figure E-33.

5. Browse to your license file and click Open. 
The license file is read and the licensed feature is added to the license server.
An acknowledging message is displayed, see Figure E-34.

6. Click OK.
The license file contents have been read and the licensed feature has been added.

The Orbit license has now been added to the license server.

In the WlmAdmin window, license feature information may be seen by expanding the license 
host PC in the tree view. Beneath the license server PC name, the newly-added license name 
appears; for example, see Figure E-35.

Close the license tools window, WlmAdmin, when done; the license service continues to run.

Fig. E-33:  Add Feature

Fig. E-34:  WlmAdmin License Read message
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Add Orbit License to License Server
Fig. E-35:  WlmAdmin License Information
a) License Feature Name in expanded tree view.
b) License Server and Feature Information in right-hand pane.

a)

b)

License Feature NameLicense Host PC name
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VLC Video Stream Player Installation
This section describes installation of the VLC video stream player used to view the H.264 video 
streams on the ‘video wall’  PC from MV-8 Series Multiviewers with early versions of the Orbit 
Client software tool (earlier than Orbit v2.5.16). 

Later Orbit versions include a streaming video player and do not require any separate 
installation of the VLC player.

Introduction
For early Orbit versions, a VLC streaming video player is required to be running on the Video 
Wall PC. VLC is a free and open source cross-platform multimedia player from VideoLAN, which 
plays various streaming protocols and is compatible with the H.264 streamed multiviewer 
inputs from an MV-8 Series Multiviewer.

Install
The video stream player used is the 64-bit VLC player from VideoLAN (www.videolan.org).

1. Download the 64-bit VLC installer from 
http://www.videolan.org/vlc/download-windows.html

IMPORTANT
Information in this appendix only applies if
using an Orbit Client software version earlier than v2.5.16. 

This appendix does not apply for Orbit version v2.5.16 onwards, 
because Orbit has a video H.264 stream player already built in. 

Grass Valley recommend upgrading to the latest Orbit version.

System Component Requirement

VLC streaming video player 64-bit 

Note: Download and install the 64-bit installer for Windows, not the 
32-bit installer.
The correct downloaded installer file name will have the form 
‘vlc-N.N.N-win64.exe’, where N.N.N is the vlc software version 
number.
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Install
2. Run the VLC 64-bit installer.
The VLC media player Setup Wizard begins.

3. Read the license agreement and click Next. 

4. Click Next on the following screen.

5. You are invited to choose an Install Location. Use the default location on your PC. Click 
Install.
Installation begins and a progress bar is shown.

6. A completion screen is shown when VLC is installed. See Fig. F-37:.
Click Finish.
The VLC player starts up. Click Continue at the splash screen.

7. Close the VLC player. 
The VLC player is installed.

Fig. F-36:  VLC Installer 64-bit Download

Note: It is possible to specify your own VLC install location instead of the 
default. In this case, after installation, create a system environment 
variable VLC_PLUGIN_PATH and set this to the install folder path. 
(Example: VLC_PLUGIN_PATH C:\Program Files\VideoLAN\VLC)

Fig. F-37:  MV-800-DT Multiviewer Video Wall
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Multiviewer Terminology
This section describes some of the multiviewer terminology used in the manual and should be 
read alongside the example dual-screen video wall illustration shown in Figure G-1 on page 
166. 
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Fig. G-1: Example Video Wall of Two Monitor Display Screens

Video Wall

MV-8X0/8X1 Multiviewer Rear Panel 
(MV-820-HDBNC shown)

MV-8X0/8X1 Multiviewer Head Display Output 2MV-8X0/8X1 Multiviewer Head Display Output 1

Clock 
Widget

UMD 
Widget

Screen Screen

Video 
Widget

Audio Bars 
Widget

Video Tiles Clock Tile with 
Digital Clock 

widget

Tile Grid for Output 1 Tile Grid for Output 2
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 Table G-1:   Definition of Terms  

Term Definition

Wall, Video Wall One or more monitor display screens configured to form one large 
screen.

Screen Display area of one individual monitor/display device.

Theme The style and appearance of the video wall and its screen elements.

A Theme is a set of widget styles which can be applied to a project. Each 
widget may have one or more specific styles. 

Using themes, a video wall may be tailored to conform to a house style.

Style Each Widget can have several appearances, styles. Styles are changes to 
a widget’s appearance and do not affect its function. Styles can be 
grouped under themes.

Tile A rectangular area on a video wall screen, usually displaying video 
inputs and other supporting information. 

For example, a tile may display a video picture with audio level and 
other related status information. 

Other information may be displayed in tiles, for example, time, images, 
labels and/or text.

Tile Grid A multiviewer video wall screen is divided up into rectangular areas; 
various sizes and arrangements are possible. 
A tile grid can be used in the Grass Valley Orbit tool for quick-positioning 
of tile arrangements on a wall.

Fine Grid A fine grid on a Grass Valley Orbit screen is used for the fine-positioning 
of graphical elements. For example, for positioning Tiles on a wall or 
Widgets on a tile.

Widget On-screen graphical elements used to display information on tiles. There 
are one or more widgets on a tile. Displayed information includes: Audio 
sound level, Time, Text labels.

Widget types include: Audio bars, Clocks, Images, Labels, Lines, Tally 
LEDs, Timers, UMD’s, Video and Web sources.

Head Display 
Output

A 1080P or 720P output from the MV-8 Series Multiviewer. There are up 
to 12 head display outputs.

On the MV-8X0/8X1 Multiviewer product, this can be SDI (Coax or Fiber) 
or HDMI, or video-over-IP depending on the product version. 

Each head display output is then typically connected to a monitor 
display that forms all or part of a multiviewer video wall. 

Video Input One of 48 video inputs to the MV-8 Series Multiviewer in the MV-8X0/
8X1 Multiviewer product.
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Quick Start New MV-8 Series MV with GV Orbit
New MV-8 Series Multiviewer Video Wall (Default) .................................................. page 169
Edit Video Wall Layout and Configure Alarms ..........................................................  page 170

Step 1: View MV-8 Series Multiviewer Settings ............................................... page 170
Step 2: Pull Default Layout from New MV-8 Series Multiviewer ................. page 170
Step 3: Make Changes to the Wall ..................................................................... page 171
Step 4: Push the Modified Project back to the Multiviewer .......................... page 171
Step 5: Visible Alarm Warnings ........................................................................... page 172

This section describes a set of quick start steps to exercise a new MV-8 series multiviewer 
device from GV Orbit Client. This includes:

• Pulling a multiviewer project.
• Renaming the project.
• Editing the project:

• a simple visible change; and 
• applying an alarm.

• Pushing the project back to the multiviewer; and 
• Seeing alarms on-screen.

New MV-8 Series Multiviewer Video Wall (Default)
A default video tile-grid is shown on head Display Outputs 1 to 4. All 48 video input signals 
monitored by the multiviewer are shown. Additionally, ‘HH:MM:SS’ time and ‘display output 
number’ are also shown.

Fig. H-1: Default Multiviewer Video Wall (New MV-8 Series Multiviewer)

HH:MM:SS
Output number

Multiviewer 
input number 
(1 to 48 total)
Issue 1 Revision 3 Page 169 © 2019 Grass Valley, a Belden Brand



Edit Video Wall Layout and Configure Alarms
Edit Video Wall Layout and Configure Alarms
See the Grass Valley web site for GV Orbit and MV-8 Series Multiviewer user manuals. 

Perform the following steps to check basic functionality for multiviewer with GV Orbit Client, 
including editing the video wall and setting an alarm:

Step 1: View MV-8 Series Multiviewer Settings
1 Run GV Orbit Client (v4.0 or later) on a PC. 
2 Click RollCall Control Screen 

and enter the new MV-8 Series Multiviewer’s IP 
address. 

3 Click OK.

The MV-8 Series Multiviewer control screens are 
opened in a tab.

4 On the multiviewer’s System-Setup control screen, 
take a note of the MV-8 Series Multiviewer’s:

• 1G1 Interface IP address; and 
• RollCall Settings Domain ID.

5 Close the control screen tab.

Step 2: Pull Default Layout from New MV-8 Series Multiviewer
1 Click New Project and select “Connected Multiviewer 

Project”. 
2 Browse into a new and empty PC folder, where project 

data will be stored. 
Click Choose. Click Next.

A list of devices available to GV Orbit is shown.
3 Select the new multiviewer from the displayed list. 

Click OK. 

A login screen is shown.
4 Enter username and password of the project 

(default = admin, admin). 
5 Click Login. 

The project data is pulled from the device and a Project Home screen is shown. 

GV Orbit Project Screen 
6 Click Edit Name,

rename the project, 
and click OK.

(This will avoid over-writing the default 
project on the multiviewer later.)
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7 Click the Walls icon and select a wall 
item in the drop-down list (e.g. Wall1).

The wall is shown in Run mode.

8 Click the  icon to enter ‘Design 
Mode’. 

The icon turns blue and the Wall 
Editor screen is shown.

Step 3: Make Changes to the Wall

A Visible Change
1 Click on a video wall tile, to select it. 

Tile Properties are shown on the right-hand side.  
2 Change property Preferences > Type to Analogue Clock.

The selected tile changes to a round clock face.
3 Click Project > Save File in the main menu to save this change.

Enable an Alarm

To enable a ‘Video Input Lost’ alarm:

4 Click Multiviewer > Input Alarms in the main menu. 

A dialog is shown with tabs. On the:
• Input Tab - Set Selected Input to Input 1.
• Alarm Tab - Scroll down Select Alarm box 

and select Video Input Lost. 
Select Alarm Enable.

• Input Tab - Click Copy All.
5 Click OK.  
6 Click Project > Save File.

The Video Input Lost alarm is enabled on all the multiviewer’s 48-input multiviewer inputs. 

Step 4: Push the Modified Project back to the Multiviewer
1 Click Project > Push. 
2 Ensure the project name is selected and click OK.

The MV-8 Series Multiviewer adopts the new wall layout: 
An analogue clock is shown.
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Step 5: Visible Alarm Warnings
To provoke a ‘Video Input Lost’ alarm:

1 Disconnect a signal going to the 48-input multiviewer (for example, Input 25). 
I.e. disconnect signal at the MV-8 Series Multiviewer’s Video Input connector. 

Video loss is detected at the 48-input multiviewer input.
A slow-flashing, red rectangular border appears around the 
corresponding video wall tile.

Alarms may also be seen in the GV Orbit Client’s Network window 
and in the Alarm Summary window for the multiviewer:

2 In the Network window,
locate and expand the MV-8 Series Multiviewer item.

3 Right-click on a sub-item of the multiviewer item (for example, the red Input 25 ‘sub-item’) 
and select Alarms in drop-down menu. 

An Alarm Summary window shows the 48-input multiviewer’s Input 25 status. See 
Figure H-2.

Fig. H-2: Alarm Showing in:
a) Network Window. 
b) Alarm Summary Window.

a) Network window

b) Alarm Summary window
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Grass Valley Technical Support
Contact Us

Grass Valley Technical Support
For details of our Regional Customer Support Offices please visit the Grass Valley web site and 
navigate to Support/Customer Support Contacts.

https://www.grassvalley.com/contact/support/

Customers with a support contract should call their personalized number, which can be found 
in their contract, and be ready to provide their contract number and details.

Corporate Head Office
Grass Valley

3499 Douglas-B.-Floreani

St-Laurent, Quebec  H4S 2C6

Canada

Telephone:+1 514 333 1772

Fax:+1 514 333 9828

www.grassvalley.com
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